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1. Introduction 

 
Purpose 

The School of Information and Library Science (SILS) is a professional 

school that seeks to prepare students for careers in Information and Library 

Science.  The school also encourages both faculty and students to take part in  

and to submit scholarly research.  SILS faculty, staff, and students rely on 

servers that are housed in Manning Hall to keep their data, papers, research, 

and personal documents.  What would happen if a disaster strikes SILS?   

 

We live in a time where we must be prepared for almost anything.  Many 

schools and organizations make the mistake of not preparing for potential 

crisis situations in advance. As a result, schools and organizations often make 

erroneous decisions, waste critical time and allow the crisis to control them 

and/or spiral out of control.  An actual crisis is not the time to try to figure out 

what actions to take, whom to contact or how to communicate with your 

various employees, staff, and students.  Being fully prepared ahead of time 

can be the difference between keeping your business up and running or going 

out of business. 

 

The threat of terrorist attacks has certainly been elevated since September 11, 

but continuity planners at educational institutions have other concerns as well.  
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Many universities rely on their stellar reputations in particular fields of study 

to boost enrollment.  These reputations are built around strong research 

programs, which take years of demonstrative continuity and discipline to 

achieve.  In addition, research may be funded by grants from private or 

government entities such as the National Institute of Health (NIH).  By 

accepting those grants, colleges and universities commit to the responsible 

and prudent management of funds and compliance with regulatory guidelines.  

If you have grants, and a disaster impacts your lab environment and you can’t 

continue the research, you potentially will lose grant money, and the 

reputation of the entire research program could suffer.  It is very important for 

universities to maintain their reputations.  In addition, research data is 

significant and must be protected.   

 

Methodology 

Before the project can even start, I must have the total support from the 

higher-ups in the school. I met with Dean Marshall to define and agree on the 

scope of the project.  I sent her an email stating the information that would be 

required from each member of staff.  This information gave me a general 

understanding of each staff member’s responsibility and IT requirements.    

 

It was recommended that I establish a planning team to develop the recovery 

procedures, however, since it is a small school with a few business functions, I 

think that with the help of the staff named in Step1 (below), I could do a good 
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job.  I made sure all employees, and staff were aware of the plan and its 

contents 

1. Identify business representatives. 

Business unit plans should identify a business representative authorized to 

determine recovery requirements. This person should also have the power to 

approve funding.  From my knowledge both Ms. Lucia Zonn and Ms. Angie 

Heinisch would be good sources from the business aspect of the school while 

Mr. Scott Adams would represent the technology infrastructure. 

 

2. Establish client participation and user acceptance. 

The recovery team will consist of individuals who are currently assigned to 

the day-to-day support of the IT infrastructure.  This team should also run 

quarterly drills and update the procedures when it is needed. Client 

participation in plan development and user acceptance testing is required in 

order to obtain successful results. 

 

3. Locate vulnerabilities in the technology infrastructure. 

In the past, the words "risk analysis" have meant the process of identifying 

and minimizing exposure to certain threats that an organization may 

experience. Traditionally, this process would not include vulnerabilities in the 

technology infrastructure. With today’s businesses relying on technology, a 

good risk analysis is fundamental to a successful business continuity program.  
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Scott Adams and Cheryl Lytle were my contacts for this part of the project.  I 

requested manuals or procedural documentations.  I analyzed the steps and put 

into place procedures for when the “what if” happens.  

 

4. Identify technology requirements. 

The technology requirements for a successful recovery must include hardware 

and software equivalents to production.  I interviewed Mr. Adams to gain an 

understanding of all machines and servers and the services that were provided. 

 

6. Develop a recovery strategy. 

The school needs will dictate the recovery strategies and recovery time 

objectives (RTO).  RTO is defined by the business as the amount of down 

time their application can endure. The recovery time requirements of 

interdependent applications must be taken into consideration. Two key 

components to any contingency program should include a strategy to back up 

and restore vital records. 

 

Any down time in SILS, depending on the time of the semester, could be 

detrimental.  Most students and faculty store critical information on the 

servers such as Kiwi and Ruby.  For those who are doing research, downtime 

or lost data could have serious impacts, not to mention the frustration of 

duplicating efforts and lost time. 
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7. Create vital records and provide offsite storage. 

A critical component in plan development is the selection of backup and 

restoration software capable of storing and successfully retrieving data. 

Without this, there is no business continuity program. Backup scheduling 

must include an off-site storage location. 

 

Once the data is carefully backed up, it must be accessible in the event that the 

facility is not accessible. There are bonded commercial storage vendors that 

provide security and offsite data storage.  However, with finances being a 

problem, I recommend that SILS and another department, such as Computer 

Science, use each other’s facility as offsite storage. 

 

8. Build the plan. 

A critical step in plan development is actually building the plan.  This is 

where the majority of the work was performed.  Any group or individual 

providing a product or service on a day-to-day basis should also be 

responsible for supporting the service during a contingency event. 

 

9. Obtain user evaluation sign-off. 

Users should be asked to provide their views on the testing process, as well as 

on the results of the test.  A copy of the IT Recovery Plan was given to both 

Ms. Lytle, and Mr. Adams so that they could provide comments, 

improvements, and modifications that they would like to see. 
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 Analytical Approach 

• Conduct contextual interviews with people who play important roles in all 

the IT functions in the school to understand the processes and procedures, 

and to find out how each function relates to each other and the overall 

goals of the school.   

• While gathering data, identify the best practices for IT Recovery. 

• Analyze the differences between what is practiced and the “best 

practices”. 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 11

2. Recovery Team and Responsibilities 
 

2.1 Steps for an Orderly Shutdown when Time Permits 
 

Sun Machines 
- logon as root on a console or remotely (ssh2) 

 
# shutdown –i6 –g0 –y 

 
   Machines 

- ruby 
- onxy 
- pearl 
- jade 
- tardis 

 
Linux 

- logon as root console or remotely (ssh2) 
 

# shutdown –h 
 
   Machines 

- ella 
- opal  
- video 
- miles 
- idl 
- neoref 

  
WinServer 

- logon as Admin 
 

Start -> Shutdown -> Shutdown -> Enter/Ok 
 
   Machines 

- kiwi 
- falcon 
- guinea 
- pelican 
- phoenix 
- owl 
- ils-ghost 

 
NetApps 

- logon as root  
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# halt 
   

Machines 
- duck 

 
 

Order of Shutdown  
- ruby 
- duck 
- onxy 
- kiwi 
- falcon 
- pearl 
- owl 
- jade 
- guinea 
- pelican 
- phoenix 
- tardis 
- video 
- idl 
- neoref 
- miles 
- opal 
- ella 
- ils-ghost 
   

 
 2.2 Emergency Notification List 

 
Name Office Phone Home Phone 
Scott Adams 
Director of Information 
Technology 

(919) 962-0235 (919)-929-0612 

Cheryl Lytle 
Assistant Director for 
Information Technology 

(919) 962-8188 (919) 408-0391 

Lucia Zonn 
Student Services Manager 

(919) 962-7601 (919)-942-0628 

Joanne Marshall 
Dean  

(919) 962-8363 (919)-929-9162 

Roger Patterson 
Associate Vice Chancellor, 
Finance 

(919) 962-7242  

OTHERS AS NEEDED   
University Police (919) 962-6565  
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Fire, Police, Emergency 
Medical  

911 

 
 

 2.3 Team Management and Their Responsibilities 
  

Member Responsibilities 
Scott Adams  Rebuild all Unix and Linux servers 
Cheryl Lytle Rebuild all Windows/NT servers 

 
  

2.4 Team Members Addresses and Telephone Numbers 
 

Team Members Address Telephone Number 
Scott Adams 29 North Circle Drive 

Chapel Hill  
NC 27516 

919-929-0612 

Cheryl Lytle 4707 Carlton Crossing Drive 
Durham 
NC 27713 

919 408-0391 

 
 
2.5 Damage Assessment Checklist 
 

Item Required Repair/ 
Replacement 

Person 
Assigned 
Responsibility 

Planned 
Completion 
Time/Date 

    
Building    
    
Access to 
Building 

   

    
Computer 
Facilities 
Power 

   

Electrical 
Distribution 
System 

   

Cable Controls    
Air 
Conditioning 

   

Water Cooling    
Flooring    
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Computer 
Equipment 

   

    
Storage    
Tapes    
Library/Jukebo
x 

   

    
Forms    
    
Documentation 
On-Site  

   

    
Telephone 
Equipment 

   

    
Office 
Furnishing 

   

 
 
2.6 Alphabetical List of All Employee Names, Addresses 
 

Name  Address/Phone 
ADAMS, Scott 
Director of Information 
Technology 

29 North Circle Drive 
Chapel Hill 
NC, 27516 

BARREAU, Deborah 
Assistant Professor 

(919)-401-0055 

BOYETTE, Beth 
Assistant Student Services 
Manager 

(919)-854-9916 

CARR, David 
Associate Professor 

(919)-968-3383 

CHAFFIN, Kristin 
Instructor 

 

DANIEL, Evelyn 
Professor 

(919)-929-2237 

GOLLOP, Claudia 
Associate Professor 

(919)-493-1159 

GRAHAM, Stacy 
SILS Library Technical 
Assistant 

(919)- 929-6253 

GREENBERG, Jane 
Assistant Professor 

(919)- 401-0591 

HAAS, Stephanie 
Associate Professor 

(919)- 544-0643 
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HEINISCH, Angie 
Assistant to the Dean 

4304 New Brighton Drive 
Apex, NC 27539 
919-280-7171 

HEMMINGER, Bradley 
Assistant Professor 

(919)- 942-2273 

HEWITT, Joe 
Professor and Associate 
Provost for Univ. Libraries 
and Director of Academic 
Affairs Libraries 

 

HOLLEY, Edward 
William Rand Kenan Jr. 
Professor 

 

JACKSON, Shawn 
Director of Development 

6724 Eastbrook Drive 
Raleigh 
NC 27615 
919-844-9066 
C - 919-622-5332 

JONES, Paul 
Director of ibiblio.org 

(919)- 932-7285 

KILGOUR, Frederick 
Distinguished Research 
Professor 

(919)- 968-4305 

LEE, Jonghoon 
Instructor 

(919)- 450-0868 

LAMBSON, Ann 
Student Services & 
External Affairs Assistant 

(919)- 932-3268 

LOSEE, Robert 
Professor 

(919)- 929-0370 

LYTLE, Cheryl 
Assistant Dir. For 
Information Technology 

4707 Carlton Crossing Drive 
Durham, NC 27713 
919 408-0391 

MARCHIONINI, Gary 
Cary Boshamer 
Distinguished Professor 

(919)- 929-4072 

MORAN, Barbara 
Professor 

(919)- 967-8541 

NEWBY, Gregory 
Assistant Professor 

(919)- 563-9947 

SAYE, Jerry 
Professor 

(919)- 968-1436 

SOLOMON, Paul 
Associate Professor and 
Associate Dean 

(919)- 933-3893 

SONNENWALD, Diane (919)- 969-7581 
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Associate Professor 
STURM, Brian 
Assistant Professor 

(919)- 968-8920 

TAUBER, Marcia 
Office Assistant 

105 Anglese Court 
Chapel Hill  
NC 27516 
(919)- 929-6248 

THOMAS, Susan 
Administrative Manager 

170 Offset Farm Road 
Sanford, NC  27332 
919-962-0182  (Work) 
919-258-6966  (Home) 

TIBBO, Helen 
Associate Professor and 
Francis Carroll McColl 
Term Professor 

(919)- 929-6248 

VARGHA, Rebecca 
Librarian of SILS 

(919)- 544-6045 

WILDEMUTH, Barbara 
Professor and Associate 
Dean, Undergraduate 
Studies 

(919)- 968-3018 

ZONN, Lucia 
Student Services Manager 

104 Stonehill Road 
Chapel Hill NC 27516 
H 919-942-0628 

 
 

2.7 Customer Contacts for Recovery 
   

2.7.1 Campus Services 
 
Environment, Health and 
Safety 
Pete Reinhardt 
Director, EH&S 
Work (919) 843-5913 
Home (919) 929-1970 

 
Mary Crabtree 
Workplace Safety Director 
Work (919) 962-5719 
Home (919) 932-1438 

UNC One Card 
Mike Freeman 
Card Applications Director 
Work (919) 962-2407 
Home (919) 732-7260 

 
Craig Hyatt 
Manager – Information 
Technology 
Work (919) 962-3270 
Home (919) 542-5596 

Person ID 
Mike Freeman 
Card Applications Director 
Work (919) 962-2407 

 
Megan Keefe 
PID Administrator 
Work (919) 962-9561 
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Home (919) 732-7260 Home (919) 968-0714 
Student Stores Retail 
John Jones 
Student Stores Director 
Work (919) 962-5066 
Home (919) 489-1972 

 
Jim Powell 
Controller, Student Stores 
Work (919) 962-5066 
Home (919) 383-1416 

Transportation and Parking 
Connie McPherson 
Asst. Dir. Administrative 
Services 
Work: (919) 962-7145 
Home: (336) 376-6566  

 
Todd Arnold 
Computing Services 
Manager 
Work: (919) 962-5027 
Home: (919) 967-1201 
Pager: (919) 216-1602 

Printing Services 
Susan Anderson 
Printing Services Director 
Work: (919) 962-2400 

 
Mike Rosenmarkle 
Computing Consultant 
Work: (919) 962-5566 
Home: (919) 489-1148 

UNC-TV System 
Delores Campbell 
Director of Development  
Work: (919) 549-7128 

 
Arnetta Campbell 
Supervisor, Contributor 
Services 
Work: (919) 549-7134 

Electronic Forms Systems 
Dennis Press 
Controller 
(919) 962-5563 

 

General Alumni Association 

Director 
(919) 962-1208 

 
Roger Nelsen 
Director, Records 
(919) 962-1208 

Carolina Fund 
Matt Kupec 
Associate Vice Chancellor for 
Development 
(919) 962-1560 

Jean Vickery 
Director of Development 
Services 
(919) 962-3429 
 

 
 

2.7.2 Students Information Applications 
 
 
Registrar’s Office 
David Lanier  
University Registrar 
(919) 962-8291 

 
Donna Redmon 
Associate University 
Registrar 
(919) 962-3954 
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Undergraduate Admissions 
Jerry Lucido 
Director, Admissions  
(919) 966-3990 

 
Herb Davis 
Asst. Director, 
Admissions 
(919) 966-3993 

Graduate Admissions 
Cheryl Thomas 
Director of Student Records, 
Graduate School 
(919) 962-6312 

 

Student Aid 
Shirley Ort 
Director, Student Aid 
(919) 962-9246 

Vincent Amoroso 
Asst. Director for 
System Mgmt. 
Student Aid 
(919) 962-2191 

Student Loans 
Shirley Ammon 
Collections Officer, Student Loans 
(919) 962-9482 

 

Cashier’s Office 
Angie Davis 
Director 
(919) 962-5848 

 
Gwen Norwood 
Assistant Director 
(919) 962-5851 

Housing 
Christopher Payne 
Director 
(919) 962-5404 

 

Faculty/Staff Bulletin 
Tony Harvey 
Catalog Editor, Records Publications 
(919) 962-3761 

 

Athletic Association 
Janice Hillard 
Director of Athletic Academics 
Affairs 
(919) 966-4102 

 

Space Utilization 
Karen Copeland Drafting Technician 
Planning Office 
(919) 966-1571 
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Institutional Research 
Lynn Williford 
Acting Dir., Institutional Research 
(919) 962-1500 

 
Myron Dunston 
Research Assoc. 
(919) 962-1333 

 
 
2.7.3 Financial Systems 

 
Financial Accounting System 
Dennis Press 
Controller 
(919) 962-1370 

 
F. John Case 
Director, Contracts/Grants 
(919) 966-2542 

Accounts Payable System 
Martha Pendergrass 
Director Accounts Payable 
(919) 962-0213 

 

Petty Cash Monitor System 
Assistant Controller 
(919) 962-0036 

 

Chart of Accounts System 
Assistant Controller 
(919) 962-0036 

 

Cashier’s Office 
Angela Davis 
University Cashier 
(919) 962-1368 

 

Asset Accounting 
Candi Woody 
Director of Asset Accounting 
(919) 962-1382 

 

General Administration 
Jeff Davies 
Assistant VP for Finance 
(919) 962-1000 

 

Central Warehouse and Stores 
Nancy Franusiszin 
Interim Director, Materials 
Management 
(919) 962-5671 

 
Nancy Franusiszin 
Interim Director, Materials 
Management 
(919) 962-5671 

Purchasing 
Phil Chernesky 
Associate Director, Purchasing 
(919) 962-3774 

 
Phil Chernesky 
Associate Director, 
Purchasing 
(919) 962-3774 

Investment Office 
Mark Yusko 

Accounting Services 
Carolyn Sturgess 
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Chief Investment Officer 
(919) 962-2002 

Director 
(919) 962-5512 

 
 
2.7.4 Health Services 
 
UNC P&A System 
Rick Deese 
Director of Fiscal 
Operations 
UNC Physicians & 
Associates 
(919) 966-1591 

 
Tom Sibert, MD 
Executive Vice 
President 
UNC Physicians & 
Associates 
(919) 966-1591 

 
Beacham Wray 
Director of 
Managed Care 
UNC Physicians 
& Associates 
(919) 966-1591 

Wendell Roberts 
Director of 
Ambulatory Care 
Administration 
UNC Physicians & 
Associates 
(919) 966-1591 

Jeanne Chamberlin 
Director of 
Financial 
Operations 
UNC Physicians & 
Associates 
(919) 966-1591 

 

 
 
2.7.5 Human Resources and Payroll  
 
UNC-CH Payroll 
Dennis Press 
Controller 
(919) 962-1370 

 
Betsi Snipes 
Payroll Director 
(919) 962-0046 

Human Resources 
Laurie Charest 
Associate Vice Chancellor, Human 
Resources 
(919) 962-1554 

 
Sharon Nieves 
Manager, HRIS 
(919) 962-2553 

 
 
2.7.6 Telecommunications 
 
Telecommunications 
Steve Harward 
Director, Telecommunications 
(919) 962-0004 

Tom Horne 
Director of Financial 
Services, ATN 
(919) 962-0303 
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Facilities Services Systems 
Edward Mann 
Systems Accountant, Facilities 
Services 
(919) 962-2182 

Edward Phillips  
Director, Business 
Operations, Facilities 
Services 
(919) 962-8069 

Mailing System 
Jim White 
Supervisor, Printing Services 
(919) 962-2182 

 
Susan Anderson 
Manager, Printing Services 
(919) 962-5566 

Campus Directory System 
Steve Harward 
Director, Telecommunications 
(919) 962-0004 

 
Annette Harmon 
Campus Directory 
Coordinator 
(919) 962-1608 

 
 

 2.8 Team Headquarters 
 

To be determined, based on type and severity of disaster 
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3. Equipment 
3.1 Computers in the Lab 
 

This information is detailed in Appendix A (pg 93). 
 
 
3.2 Tape Library and Tape Management Systems 

 
The Backup Server and Library 
 

Onyx, the backup server, is a Sun Microsystems Enterprise 250 
machine running Solaris 2.8 with version 6 Solstice for Unix, Network 
edition.  The Networker for Unix Network edition came as part of the 
package; however, it only allowed 10 machines to connect at a time, 
which is not sufficient for out school.  Two extra modules of 
Networker Client Connection were purchased, each allowing 25 
connections giving us a total of 60 connections at a time.  In addition, 
modules for each type of Operating System, that would need to be 
backed up, were purchased – Client for Linux, Client for Unix, and 
Client for Windows.  
 
The Library is a Sun Microsystems StorEDGE L1000 and it was made 
by ATL (Automated Tape Library).  It is connected to Onyx via a 
differential SCSI cable and contains two DLT 7000 drives (it has the 
capacity to hold four drives) that cost approximately $5100 each.   

 
 

How to start the Networker Administrator Program 
 

Enter the following command at the prompt to start the Networker 
Administrator program:  

 
# nwadmin & 

 
 
Back up Process 
 

The Library stores 30 DLT tapes, which are used to backup the data 
for SILS.  Backup is separated into two groups: Schedback and 
Schedlaptop.  Each group has their own tapes and these tapes can only 
be used to backup machines from their respective groups, example, 
DLT C1### can only be used to back up laptops.  In the Library are 27 
tapes for Schedback, 2 tapes for Schedlaptop, and a cleaning tape 
 
The Schedlaptop group comprises of faculty and staff’s laptops and 
Schedback has all faculty and staff’s desktops.  These groups were 
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devised since different machines are backed up at different times and 
with different sequences (full backups or incrementals). 
Every Friday, the DLTs with the newest data are removed from the 
Library and stored in racks in Scott’s office.  It has been Scott’s 
practice to remove 14 tapes with the most recent backups every 
Friday; this provides enough tapes for a full week of backups.  Tapes 
that were removed two weeks prior, allowing up to 2 weeks to be 
recovered at all times replace these tapes. 

 
How to Configure a Schedule Backup 

  
1. Select Customize>Groups to open the Groups window 
2. Select Enabled in the Autostart attribute, and then click 

Apply. 
 Your NetWorker server in now configured  

 
 How to Start a Backup Immediately 
 

1. Select Customize>Groups to open the Groups window. 
2. Select Start Now in the Autostart attribute, and then click 

Apply. 
 Your NetWorker server will back it up immediately. 

 
 How to perform a manual backup initiated from the client 

  
Type nwbackup –s servername 
This displays the nwbackup program and –s specifies the 
NetWorker server  

 
 How to recover Networker servers 

  
Type nwrecover –c client –s server 
Use the –s server option to specify a particular NetWorker 
server on the network.  Use the –c client option to specify a 
particular NetWorker client on the network.  This command 
also displays the nwrecover program. 

 
 How to Recover Bootstrap Data from Another Server’s Tapes Using 

mmrecov (Unix to Unix or Win to Win) 
 

1. Move the physical media to the recovering sever 
2. Run mmrecov to recover the media database and resource files. 
3. Shut down the NetWorker server and replace the default resource 

files with those that were recovered by copying or moving them 
from /nsr/res.R to /nsr/res. 

4. Add the recovering server to the old server’s remote access’ list. 
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5. Run nsrck – L7 old_server to recover the server’s indexes. 
 

The command line program mmrecov will now recover the media 
index and server’s resources files independent of the server’s file 
index.  

 
All backups are logged on Onyx, in addition, Onyx sends  daily email 
notifications to Scott showing all the machines that were backed up 
successful and those that were unsuccessful (the bootstrap 
notification).  Here is a list of Preconfigured Notifications that are 
available from the Networker server 

  
Notification NetWorker Response 
Bootstrap Prints the bootstrap information on the 

NetWorker server’s default printer. 
Cleaning cartridge 
expired 

Sends e-mail to root: replace the expired 
cleaning cartridge 

Cleaning cartridge 
required 

Sends e-mail to root: insert a cleaning 
cartridge. 

Device cleaned Sends e-mail to root: device cleaning is 
complete. 

Device cleaning 
required 

Sends e-mail to root: clean the device. 

Device disabled Sends e-mail to root: a device has been 
automatically disabled. 

Index size Sends e-mail to root: check the size of 
the client file index because it will soon 
exceed the space available. 

Log default Directs the UNIX syslog facility 
(/usr/bin/logger) to log information from 
the /nsr/logs/messages file into the 
appropriate system log file. 

Migration attention Sends e-mail to root: check the status if 
a migration operation. 

Migration completion Sends e-mail to root: a migration 
operation is complete. 

Registration Sends e-mail to root: check the 
registration status 

Savegroup completion Sends e-mail to root: degree of success 
in completing scheduled backups, 
cloning, and archive operations. 

SNMP notification 
request 

Sends notification through the 
configured trap. 

Tape mount request 1 
Tape mount request 2 
Tape mount request 3 

Requests media be mounted in a device 
and: 

1. Displays a pending 
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message. 
2. Sends e-mail. 
3. Logs a message to 

syslog. 
 

 
Recommendations – Print notifications 
Scott is the only person that gets these notifications.  If Onyx goes 
down he can recover these notifications from Ruby but if they both go 
down recovering the SSIDs on each tape would be exhausting.  I 
suggest that these notifications be printed daily, kept in a folder for a 
two week period. 

To Print Notifications  
 Type nsrlpr –P printer_name 

 where printer_name (printer name cannot contain spaces) is the name 
of the selected printer.  Select Customize>Notifications and select the 
notification you want to print. 

  
Other notifications such as Savegroup completion and messages 
generated by the NetWorker server daemons (nsrd, nsrindexd, 
nsrmmdbd, and nsrmmd), which are contained in the NetWorker 
messages log and daemon.log file (/nsr/logs), should also be printed 
 
NetWorker Server Statistics and Diagnostics Reports should be 
monitored weekly for warning and error conditions and notices of lost 
connections (/nsr/logs/messages). 

 
Backup Schedule for Machines at SILS 
 
Type of Machine Full Backup Incrementals 

Faculty Wednesdays at 7:30 pm. 
(Including PHD machines 
and Library 1,2,3) 

Everyday PCs 

Staff Fridays at 4:00 am Everyday 
Win Servers Sundays at 12:01 am 

(Falcon, Kiwi, Pelican, 
Guinea, Hawk, Owl – only 
c:\inetpub) 

 

Sun Fridays at 10:00 pm 
(except Pearl and Jade – 
full backups on Tuesday) 
all partitions are backed up.  
All  

 

Linux Mondays at 2 am Everyday 
Laptops (Professors) Thursdays at 6:00 pm No incrementals
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Onyx (Linux) 
 
Onyx needs to have these five processes running for it to be considered 
“up and running”, and they are nsrd (manages main processes), 
nsrmmdbd (keeps track of tape), nsrexed (client), nsrindexd (keeps 
track of data), and nsrmmd. 
To start all services – logged in as root type /etc/rc3d/S95networker 
start 
To stop all services – logged in as root type nsr_shutdown 
 
From home – log into Onyx and type nsrwatch 
 
Win 
To recover data from local client -> Programs -> Accessories -> 
Networker Group 
 
Unix 
Type nwadmin 

 
   

How to Label and Mount a DLT 
 

1. Apply the bar code on DLT 
2. Insert an unlabeled or recyclable tape in the Library 
3. Select the appropriate device (DLT) in the Devices list of the  

NetWorker Administrator program. 
4. Select Media>Label of click the Label toolbar button to open the 

Label Window. 
5. Check the Mount After Labeling attribute and click OK. 
 
The NetWorker server automatically labels the volume and then 

mounts the volume into the device. 
 

 
3.3 Office Equipment 
 

Manuals - For Equipment 
- Third Party Administrative Books 

Licenses -  File Cabinet 
Software -  File Cabinet 
Records -  Purchasing 

-  Operations 
-  Letters 

Backup Tapes -            Current 
Supplies - Bulbs 

- Backup Tapes (DLT IV- AIT II) 
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Media -            Microphones 
- Keyboards 
- External Hard Drive 

VCON -             Video Conferencing Camera 
Vigo -             Web Camera 

 
 Recommendations: 

All software licenses, records should be photocopied and 
kept offsite and all new software should be copied to 
another cd and also kept offsite. 

 
 
3.4 Vendor Contact List for Equipment 
 

Vendor Note Telephone 
CDWG (Nora) Nora Weeks – verbal 

contract: we have an 
agreement with them and 
all you need is the K 
number from ITP in order 
to place order. 

1-866-339-6940 

Student Stores Sue Wexler – Software 
Purchases 

919-962-3760 

Triangle Office 
Equipment 

Trey Jones - Furniture (cell) 919-291-
1998 
(w) 919-929-
4203 

OneCard Office - 
Auxiliary Services 

Jim Clinton  – Contact for 
money for printing on 
students cards 

919-962-2410 

Memory 4 Less Sandy 1-800-821-3354 
ext. 1218 

MCI Brett Kelchener - 
Projectors and class room 
visual display stuff 

919-462-9300 

Dell Kelley Carter  1-800-274-7799 
ext. 68237 

Dell Sam Lucchese 919-785-9099 
Microsoft MSDN AA # 055868666439421 

http://www.msndaa.net 
 
(fax) 661-775-
6475 

Oracle OAI CSI # 3584819 
Email: 
oaiteam_us@oracle.com 

(fax) 650-633-
1034 

 Network Appliance Eric Melvin 
System id for Filer: 

919-993-5634 
(support) 919-
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0033603449 941-7713 
UNC Contract 
Equipment/Software 

Suzi Conti – much have a 
facs id. in order to use ITP 
system 

 

Staples Marsha Tauber  
                                    
SUN 
(Alphanumeric) 

Rob Vanderberry (p) 
919.376.4495 
(c) 919.696.3500
(f) 919.872.1440 

 
 
3.5 Vendor Contact List for Service 

 
Vendor  Note Telephone 
Sony Parts  1-800-488-7669 
Sun Support  1-800-872-4786 
Electronic Shop List of people who would get 

noticed when the alarm goes 
off 

919-966-5582 

 
 

3.6 Potential Backup Installations 
 

ATN has a service called ATN/Systems Enterprise Recovery 

Group.  Their mission is to use these Data Backup Procedures to 

provide all ATN/Systems with efficient, reliable backup of their 

critical data.  They accomplish this by using Tivoli Storage 

Manager (TSM).  TMS is an automated, enterprise-wide storage 

management application for the network.  This application has two 

components: a central server and a free client (that is gui or text 

managed).  This client software package will, when correctly 

installed, send daily backups over the network to the TSM servers.  

These backups are performed using an incremental-forever backup 

structure.  The client package also provides the user with the 

capability to perform manual backups and restores. 
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TSM will backup either all disk local to the system, or data as 

defined in the user’s option file.  All files backed up from your 

client node are governed by the 90 days management class.  The 

current version, and up to four previous versions, of a file will be 

kept in data storage when the file exists on the client node.  If the 

file no longer exists on the client node, it and its four previous 

versions remain in data storage.  Deleted and previous versions are 

being retained for at least 90 days. 

 
 
3.7 Lab PCs applications and specs. 
 
 

Laptop 
Name 

Processor 
Count 

RAM Manufacturer MAC Address Serial No. 

PC1 Genuine 
Intel 
Pentium 
4 MMX 
1300 Mhz 

256 
MB 
total 

Dell 8100 00B0D014E5B
D 

2Q34B01 

PC2 Genuine 
Intel 
Pentium 
4 MMX 
1285 Mhz 

256 
MB 
total 

Dell 8100 00B0D016330A 9744B01 

PC3 Genuine 
Intel 
Pentium 
4 MMX 
1285 Mhz 

256 
MB 

Dell 8100 00B0D0164965 1Q34B01 

PC4 Genuine 
Intel 
Pentium 
4 MMX 
1285 Mhz 

256 
MB 
total 

Dell 8100 00B0D016331C 8644B01 
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PC5 Genuine 

Intel 
Pentium 
4 MMX 
1300 Mhz 

256 
MB 
total 

Dell 8100  00B0D0163260 G644B01 

PC6 Genuine 
Intel 
Pentium 
4 MMX 
1300 
Mhz 

256 
MB 
total 

Dell 8100 00B0D01640C1 1T34B01 

PC7 Genuine 
Intel 
Pentium 
4 MMX 
1300 
Mhz 

256 
MB 
total 

Dell 8100 00B0D01641A1 7Q34B01 

PC8 Genuine 
Intel 
Pentium 
4 MMX 
1300 
Mhz 

256 
MB 
total 

Dell 8100 00B0D0161DBD 3844B01 

PC9 Genuine 
Intel 
Pentium 
4 MMX 
1300 
Mhz 

256 
MB 
total 

Dell 8100 00B0D01640CB C844B01 

PC10 Genuine 
Intel 
Pentium 
4 MMX 
1300 
Mhz 

256 
MB 
total 

Dell 8100 00B0D01632B6 G744B01 

PC11 Genuine 
Intel 
Pentium 
4 MMX 
1300 
Mhz 

256 
MB 
total 

Dell 8100 00B0D01640DA 2T34B01 

PC12 Genuine 
Intel 
Pentium 
4 MMX 
1300 
Mhz 

256 
MB 
total 

Dell 8100 00B0D01632F3 6244B01 

PC13 Genuine 
Intel 
Pentium 
4 MMX 
1300 
Mhz 

256 
MB 
total 

Dell 8100 00B0D0163269 2744B01 

PC14 Genuine 256 Dell 8100 00B0D0164081 HP34B01 
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Intel 
Pentium 
4 MMX 
1300 
Mhz 

MB 
total 

PC15 Genuine 
Intel 
Pentium 
4 MMX 
1300 
Mhz 

256 
MB 
total 

Dell 8100 00B0D0163340 9244B01 

PC16 Genuine 
Intel 
Pentium 
4 MMX 
1285 
Mhz 

256 
MB 
total 

Dell 8100 00B0D016335E 2644B01 

PC17 Genuine 
Intel 
Pentium 
4 MMX 
1300 
Mhz 

256 
MB 
total 

Dell 8100 00B0D01640AD 4Q34B01 

PC18 Genuine 
Intel 
Pentium 
4 MMX 
1285 
Mhz 

256 
MB 
total 

Dell 8100 00B0D016330B D644B01 

PC19 Genuine 
Intel 
Pentium 
4 MMX 
1300 
Mhz 

256 
MB 
total 

Dell 8100 00B0D0163331 4644B01 

PC20 Genuine 
Intel 
Pentium 
4 MMX 
1300 
Mhz 

256 
MB 
total 

Dell 8100 00B0D01632E0 6744B01 

PC21 Genuine 
Intel 
Pentium 
4 MMX 
1300 
Mhz 

256 
MB 
total 

Dell 8100 00B0D01632BB 7544B01 

PC22 Genuine 
Intel 
Pentium 
4 MMX 
1300 
Mhz 

256 
MB 
total 

Dell 8100 00B0D01632A0 8844B01 

PC23 Genuine 
Intel 

256 
MB 

Dell 8100 00B0D0164808 3Q34B01 



 32

Pentium 
4 MMX 
1300 
Mhz 

total 

PC24 Genuine 
Intel 
Pentium 
4 MMX 
1300 
Mhz 

256 
MB 
total 

Dell 8100 00B0D01632C4 1844B01 

PC25 Genuine 
Intel 
Pentium 
4 MMX 
1300 
Mhz 

256 
MB 
total 

Dell 8100 00B0D01640BA 2944B01 

PC26 Genuine 
Intel 
Pentium 
4 MMX 
1300 
Mhz 

256 
MB 
total 

Dell 8100 00B0D01632EC C544B01 

PC27 Genuine 
Intel 
Pentium 
4 MMX 
1300 
Mhz 

256 
MB 
total 

Dell 8100 00B0D01632AA 9644B01 

PC28 Genuine 
Intel 
Pentium 
4 MMX 
1300 
Mhz 

256 
MB 
total 

Dell 8100 00B0D016336B D244B01 

PC29 Genuine 
Intel 
Pentium 
4 MMX 
1300 
Mhz 

256 
MB 
total 

Dell 8100 00B0D01632F1 F744B01 

PC30 Genuine 
Intel 
Pentium 
4 MMX 
1300 
Mhz 

256 
MB 
total 

Dell 8100 00B0D01641C5 HS34B01 

PC31 Genuine 
Intel 
Pentium 
4 MMX 
1300 
Mhz 

256 
MB 
total 

Dell 8100 00B0D0163358 G544B01 

PC32 Genuine 
Intel 
Pentium 

256 
MB 
total 

Dell 8100 00B0D0163358 G544B01 
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4 MMX 
1300 
Mhz 

PC40 Genuine 
Intel 
Pentium 
4 MMX 
1285 
Mhz 

256 
MB 
total 

Dell 8100 00B0D01641AA 5Q34B01 

PC41 Genuine 
Intel 
Pentium 
4 MMX 
1794 
Mhz 

256 
MB 
total 

Dell 8200 0008A11E9345 CNDFD11 

PC42 Genuine 
Intel 
Pentium 
4 MMX 
1794 
Mhz 

256 
MB 
total 

Dell 8200 0008A11033D95 5WRFD11 

PC43 Genuine 
Intel 
Pentium 
4 MMX 
1794 
Mhz 

256 
MB 
total 

Dell 8200 0008A10331FE CVRFD11 

PC44 Genuine 
Intel 
Pentium 
4 MMX 
1794 
Mhz 

256 
MB 
total 

Dell 8200 0008A1032C6B JTRFD11 

PC45 Genuine 
Intel 
Pentium 
4 MMX 
1794 
Mhz 

256 
MB 
total 

Dell 8200 0008A10B8342 BDZMD11 

PC46 Genuine 
Intel 
Pentium 
4 MMX 
1300 
Mhz 

256 
MB 
total 

Dell 8100 00B0D01641B3 8Q34B01 

PC47 Genuine 
Intel 
Pentium 
4 MMX 
1285 
Mhz 

256 
MB 
total 

Dell 8100 00B0D0163210 6844B01 

PC48 Genuine 
Intel 
Pentium 
4 MMX 

256 
MB 
total 

Dell 8100 00B0D016334D 5544B01 



 34

1300 
Mhz 

PC49 Genuine 
Intel 
Pentium 
4 MMX 
1300 
Mhz 

256 
MB 
total 

Dell 8100 00B0D01640D8 7T34B01 

PC58 Genuine 
Intel 
Pentium 
III MMX 
600 Mhz 

320 
MB 
total 

OptiPlex 
GX110 

00C04F09B966 GUD28 

 
 

 
3.8 Laptop applications and specs. 
 

SILS has 9 laptops, which students may borrow on a first come first serve 
basis.  They are named laptop1 through laptop9.  Like most machines in 
SILS, you can log in as yourself or user the generic logon - the laptop 
would automatically boot up and log in as the laptop2 for example, this 
depends on the name of the laptop that you borrowed.   
 

Laptop 
Name 

Processor/ 
Count 

RAM Man./ 
Model 

Product 
Name 

MAC Address Serial No. 

Laptop3 Genuine 
Intel 
Pentium III 
MMX 800 
Mhz/1 

128 MB 
total 

IBM/ 
A22 

2628UN5 0003478E10BF 78LDGAW 

Laptop4 Genuine 
Intel 
Pentium III 
MMX 900 
Mhz/1 

256 MB 
total 

IBM/ 
T22 

2647UN5 0040965014CC 783RX1P 

Laptop5 Genuine 
Intel 
Pentium III 
MMX 209 
Mhz/1 

 256 
MB 

IBM/ 
T22 

2647UN5 0003478F1751 783TH1H 

Laptop6 Genuine 
Intel 
Pentium III 
MMX 900 
Mhz/1 

256 MB 
total 

IBM/ 
T22 

2647UN5 0003478F175C 783TH0Y 
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Laptop7 Genuine 

Intel 
Pentium III 
MMX 900 
Mhz/1 

256 MB 
total 

IBM/ 
T22 

2647UN5 000943BDD09B 783TH1K 

Laptop8 Genuine 
Intel 
Pentium III 
MMX 700 
Mhz/1 

256 MB 
total 

IBM/ 
T22 

2647UN5 00409650399E 783TH2F 

Laptop9 Genuine 
Intel 
Pentium 4 
MMX 1800 
Mhz/1 

512 MB 
total 

IBM/        
T30 

2366FS7 00053C0403BA 78XMM67 

 
 

3.9   Applications that are running on all Lab machines and Laptops 
 
Applications -    ActivePerl 5.6.1 Build 

- AddressBook 
- Adobe Acrobat 5.0 
- Adobe Illustrator 10 
- Adobe Photoshop 7.0 
- Adobe Product/Adobe Studio Update 10/2001 
- Adobe SVG Viewer 3.0 
- Aladdin Expander 5.0 
- Books In Print On Disc – SUser 
- Branding 
- ConfigSafe 
- Connection Manager 
- Corporate Time 6.0 
- Crimson Editor 
- Dialog OnDisc 
- DialogLink 3.0 
- DirectAnimation 
- DirectDrawEx 
- DVDExpress 
- DXM_Runtime 
- Expinst 
- Fontcore 
- Gsview and Aladdin Ghostscript 
- HP LaserJet 8000 Printing System 
- IBM Thinkpad On Screen Sisplay 
- IBM TrackPoint Support  
- IBM Update Connector 
- ICW 
- IE 4Data 



 36

- IE5BAKEX 
- IE Data 
- IE README 
- iGrafix FlowCharter 2000 Professional 
- InstallShield Uninstall Information 
- Intel SpeedStep technology Applet 
- Intel PRO Ethernet Adapter and Software 
- Java 2 Runtime Environment Standard Edition v1.3 
- Java 2 Runtime Environment Standard Edition v1.3_02 
- Java 2 SDK, Standard Edition v1.3 
- Java 2 SDK, Standard Edition v1.3.1 
- Java 2 SDK, SE v.1.3.1, Forte for Java, CE 2.0 
- JRE 1.3.1 
- LISA – SUser 
- LiveUpdate 1.7 (Symantec Corporation) 
- Macromedia Dreamweaver MX 
- Macromedia Extension Manager 
- Macromedia Fireworks MX 
- Macromedia Flash MX 
- Macromedia HomeSite++ 
- Microsoft FrontPage 2000 SR-1 
- Microsoft Image Composer 1.5 
- Microsoft Internet Explorer 6 
- Microsoft NetShow Player 2.0 
- Microsoft Office 2000 SR-1 Disc 2 
- Microsoft Office 2000 SR-1 Professional 
- Microsoft Visio Professional 2002 SR-1 
- Mjuice Components 
- MobileOptionPack 
- Mozilla 1.0 
- Mplayer2 
- MsJavaVM 
- MSN Messenger 4.5 
- Mulberry 
- Multicast Viewer 
- NetMeting 
- Netscape Communicator 4.79 
- Norton AntiVirus Corporate Edition 
- OpenAFS for Windows 
- OutlookExpress 
- PCFriendly 
- PHAROS 4.70 
- ProCite 5 
- Quick Time 
- Ready to Program with Java Technology 
- RealJukebox 1.0 



 37

- RealPlayer 1.0 
- S3 Gamma Utility 
- S3DuoVue Utility 
- SchedulingAgent 
- Shockwave 
- ShockwaveFlash 
- SIRS Researcher 
-  SmartForce Player 
- SocketWatch 
- SPSS 11.0.1 for Windows 
- ThinkPad Assistant 
- ThinkPad Configuration 
- TopStyle Lite (Version 2) 
- Turbo XML Version 2.2 
- Tweak UI 
- Ulrich’s On Disc 
- Uninstall mail Switch Application 
- Van Dyke Technologies SecureCRT 3.4 
- VPN Client 
- WebFldrs 
- Winamp 
- Windows 2000 Service Pack 
- Windows Media Player 7.1 
- WinZip 
- X-Win32 5.3 

   
 3.10 Servers and services 

 
Falcon 
 
Falcon is the Domain Controller with IP address 152.2.81.18, serial 
number JV1VZ11, EOSC tag M68026, and UNC tag 390268.  This 
machine provides user and computer management for SILS Windows 
domain. 
- PowerEdge 2650, 2.2GHz/512K Cache 
- 2nd Processor2.2GHz/512K Cache 
- 4 GB DDR, 200MHz, 4X1GB DIMMS 
- 36GB, U160, SCSI, 1in 15K 
- Raid on Motherboard, PERC3-DI 128MB 
- Windows 2000 Server, 5 Client Access Licenses, English, 4GB 

Partition 
- Dual On-Board NICS ONLY 
- 24X IDE Internal CD-ROM, Black, for Dell PowerEdge 
- Bezel Option for Dell 
- 5 Bay SCSI Hard Drive Backplane, 2+3, (1 in only) 
- Front Keyboard Mouse Y-cable 
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- 36GB, U160, SCSI, 1in 15Km, for PowerEdge 2650 
- MR1R5, ROMB RAID 1/RAID 5, C12 for Dell PowerEdge 2650 
- 73GB 10K RPM Ultra 160 SCSI Hard Drive 
- 73GB 10K RPM Ultra 160 SCSI Hard Drive 
- 73GB 10K RPM Ultra 160 SCSI Hard Drive 
- Type 2 Contract (starting 10/22/02) – Same Day  4-Hour 7x24 

Parts and Labor  On-Site Response, Initial Year 
- Premier Enterprise Support – Gold – Advanced Software

 Support Quantity 3 Resolutions 
- Premier Enterprise Support – Gold – Premium Services,  2YR 

Extended 
- Premier Enterprise Support – Gold – Premium Services,  Initial 

Year 
- Type 2 Contract (starting 10/22/02) – Same Day  4-Hour 7x24 

Parts and Labor  On-Site Response, 2YR Extended 
- On-site Installation Declined 
- Intel Pro 1000XT, Cu-GB  Network Interface Card 
 
Phoenix 
 
Phoenix is a Domain Controller (backup for Falcon) with IP address 
152.2.81.19, serial number 1FJND21, and EOSC tag M68601.  This 
machine provides user and computer management for SILS Windows 
domain. 
- PowerEdge 2650, 2.6GHz/512K Cache 
- 1 GB DDR, 200MHz, 2X512 DIMMS 
- 36GB 10K RPM Ultra 320 SCSI Hard Drive 
- Raid on Motherboard, PERC3-DI 128MB 128MB, with Doc, for 

Dell PowerEdge 2650 
- 1.44 MB, 3.5 in, Floppy Drive Dell PowerEdge Servers 
- Microsoft Windows 2000 Server, Service Pack3, Academic Edition 
- Dual On-Board NICS ONLY 
- 24X IDE Internal CD-ROM, Black, for Dell PowerEdge 
- Bezel Option for Dell 
- 5 Bay SCSI Hard Drive Backplane, 2+3, (1 in only) 
- 36GB 10K RPM Ultra 320 SCSI Hard Drive 
- MR0R0, ROMB RAID 0/RAID 0, C11 for Dell PowerEdge 2650 
- 36GB 10K RPM Ultra 320 SCSI Hard Drive 
- Type 2 Contract (starting 2/13/03) – Same Day  4-Hour 7x24 Parts 

and Labor  On-Site Response, Initial Year 
- Premier Enterprise Support – Gold – Advanced Software

 Support Quantity 3 Resolutions 
- Type 2 Contract (starting 2/13/03) – Same Day  4-Hour 7x24 Parts 

and Labor  On-Site Response, 2YR Extended 
- On-site Installation Declined 
- CFI, Information, Hard Drive, Install Increasing Order, Factory Install 
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- CFI, Information, Validator,  910477, Order Ready, Factory Install 
- CFI Titan Code for CFI FIDA of Bypass SI 
- CFI Routing SKU, Factory Install 
- CFI, Information, RAID1, RAID0, Factory Install 
 
Miles 

 
  Miles is the Distance Education server with IP address 152.2.81.174 

 
- PowerEdge 2650, 2.6GHz/512K Cache 
- 1 GB DDR, 200MHz, 2X512 DIMMS 
- 73GB 10K RPM Ultra 320 SCSI Hard Drive 
- Raid on Motherboard, PERC3-DI 128MB 128MB, with Doc, for 

Dell PowerEdge 2650 
- 1.44 MB, 3.5 in, Floppy Drive Dell PowerEdge Servers 
- Red Hat Linux 7.3 FI with Docs 
- Dual On-Board NICS ONLY 
- 24X IDE Internal CD-ROM, Black, for Dell PowerEdge 
- Bezel Option for Dell 
- 5 Bay SCSI Hard Drive Backplane, 2+3, (1 in only) 
- 73GB 10K RPM Ultra 320 SCSI Hard Drive 
- MR0R0, ROMB RAID 0/RAID 0, C11 for Dell PowerEdge 2650 
- 73GB 10K RPM Ultra 320 SCSI Hard Drive 
- Type 2 Contract (starting 2/13/03) – Same Day  4-Hour 7x24 Parts 

and Labor  On-Site Response, Initial Year 
- Premier Enterprise Support – Gold – Advanced Software

 Support Quantity 3 Resolutions 
- Type 2 Contract (starting 2/13/03) – Same Day  4-Hour 7x24 Parts 

and Labor  On-Site Response, 2YR Extended 
- On-site Installation Declined 
- CFI, Information, Hard Drive, Install Increasing Order, Factory Install 
- CFI, Information, Validator,  910477, Order Ready, Factory Install 
- CFI Titan Code for CFI FIDA of Bypass SI 
- CFI Routing SKU, Factory Install 
- CFI, Information, RAID1, RAID0, Factory Install 
 
 
Ella 
 
Ella, in the near future, will take over the functionality of Ruby.  It has a  
serial number JNFTZ11, EOCS tag M68027, and an IP address of 
152.2.81.15 
 
- PowerEdge 2650, 2.2GHz/512K Cache 
- 2nd Processor2.2GHz/512K Cache 
- 4 GB DDR, 200MHz, 4X1GB DIMMS 
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- 36GB, U160, SCSI, 1in 15K 
- Raid on Motherboard, PERC3-DI 128MB 
- Red Hat Linux 7.3 FI with Docs 
- Dual On-Board NICS ONLY 
- 24X IDE Internal CD-ROM, Black, for Dell PowerEdge 
- Bezel Option for Dell 
- 5 Bay SCSI Hard Drive Backplane, 2+3, (1 in only) 
- Front Keyboard Mouse Y-cable 
- 36GB, U160, SCSI, 1in 15Km, for PowerEdge 2650 
- MR1R5, ROMB RAID 1/RAID 5, C12 for Dell PowerEdge 2650 
- 73GB 10K RPM Ultra 160 SCSI Hard Drive 
- 73GB 10K RPM Ultra 160 SCSI Hard Drive 
- 73GB 10K RPM Ultra 160 SCSI Hard Drive 
- Type 2 Contract (starting 10/22/02) – Same Day  4-Hour 7x24 

Parts and Labor  On-Site Response, Initial Year 
- Premier Enterprise Support – Gold – Advanced Software

 Support Quantity 3 Resolutions 
- Premier Enterprise Support – Gold – Premium Services,  2YR 

Extended 
- Premier Enterprise Support – Gold – Premium Services,  Initial 

Year 
- Type 2 Contract (starting 10/22/02) – Same Day  4-Hour 7x24 

Parts and Labor  On-Site Response, 2YR Extended 
- On-site Installation Declined 
- Intel Pro 1000XT, Cu-GB  Network Interface Card 
Guinea 
 
Guinea is the server that stores all of SILS Windows’s domain user’s 
profiles.  It is also the printer server and its IP address is 152.2.81.16. 
 
- PowerEdge 2550, Pentium III,  1.13GHz,/512K Cache 
- 2nd Processor, Pentium III,   1.13GHz/512K Cache 
- 4 GB DDR, 133MHz, 4X1GB DIMMS 
- 36GB 10K RPM Ultra 160  SCSI Hard Drive 
- 1.44 MB, 3.5 in, Floppy Drive Dell PowerEdge Servers, Factory 

Installed 
- Microsoft Windows 2000 Server F5,ACAD, Service Pack2 
- Dual On-Board NICS ONLY 
- Dell Remote Assistant Card V 2.0 w/56K PCMCIA Modem, for 

Dell PowerEdge 2450, Factory Installed 
- 24X IDE Internal CD-ROM, Black, for Dell PowerEdge 
- 4 Bay HD Split Backplane, (1.0 in Only), PowerEdge 2550 
- Electronic Documentation on CD 
- 36GB 10K RPM Ultra 160  SCSI Hard Drive 
- C10, MSMS, MB SCSI, for Dell    PowerEdge 
- 73GB 10K RPM Ultra 160 SCSI Hard Drive 
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- 73GB 10K RPM Ultra 160 SCSI Hard Drive 
- 73GB 10K RPM Ultra 160 SCSI Hard Drive with Media Cage 
- Power Supply, 330W, 2 Units, DOM, Redundant, for Dell 
- Type 2 Contract (starting 5/1/02) – Same Day  4-Hour 7x24 Parts 

and Labor  On-Site Response, Initial Year 
- Type 2 Contract (starting 5/1/02) – Same Day  4-Hour 7x24 Parts 

and Labor  On-Site Response, 2YR Extended 
- On-site Installation Declined 
- Premier Enterprise Support – Gold – Advanced Software

 Support  
- Premier Enterprise Support – Gold – Advanced Software, Extended 
- Premier Enterprise Support – Gold – Advanced Software, Initial 

COMMENT: SCOTT ADAMS ADAMS@ILS.UNC.EDU 
  
Pelican 
 
Pelican is the application server and it has an IP address 152.2.81.7. 
 
- PowerEdge 2550, Pentium III,  1.13GHz,/512K Cache 
- 2nd Processor, Pentium III,   1.13GHz/512K Cache 
- 4 GB DDR, 133MHz, 4X1GB DIMMS 
- 36GB 10K RPM Ultra 160  SCSI Hard Drive 
- 1.44 MB, 3.5 in, Floppy Drive Dell PowerEdge Servers, Factory 

Installed 
- Microsoft Windows 2000 Server F5,ACAD, Service Pack2 
- Dual On-Board NICS ONLY 
- Dell Remote Assistant Card V 2.0 w/56K PCMCIA Modem, for 

Dell PowerEdge 2450, Factory Installed 
- 24X IDE Internal CD-ROM, Black, for Dell PowerEdge 
- 4 Bay HD Split Backplane, (1.0 in Only), PowerEdge 2550 
- Electronic Documentation on CD 
- 36GB 10K RPM Ultra 160  SCSI Hard Drive 
- C10, MSMS, MB SCSI, for Dell    PowerEdge 
- 73GB 10K RPM Ultra 160 SCSI Hard Drive 
- 73GB 10K RPM Ultra 160 SCSI Hard Drive 
- 73GB 10K RPM Ultra 160 SCSI Hard Drive with Media Cage 
- Power Supply, 330W, 2 Units, DOM, Redundant, for Dell 
- Type 2 Contract (starting 5/1/02) – Same Day  4-Hour 7x24 Parts 

and Labor  On-Site Response, Initial Year 
- Type 2 Contract (starting 5/1/02) – Same Day  4-Hour 7x24 Parts 

and Labor  On-Site Response, 2YR Extended 
- On-site Installation Declined 
- Premier Enterprise Support – Gold – Advanced Software

 Support  
- Premier Enterprise Support – Gold – Advanced Software, Extended 
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- Premier Enterprise Support – Gold – Advanced Software, Initial 
COMMENT: SCOTT ADAMS ADAMS@ILS.UNC.EDU 

 
Kiwi 
 
Kiwi is currently the server that stores the home directories for all 
Windows users and it is a file server.  It is going to be replaced by Duck.  
 
Duck 
 
Duck is a NetApp F810 Filer System with IP address 152.2.81.2, and in 
the near future it is going to be the home directory for all SILS users. 
 
- F810 512MB/128 NO PROTOCOL 
- SW DataONTAP F8XXEA 
- NFS Software F810 
- CIFS Software F810 
- ADPTR, PWA QLA2200/33, HSSDC, Cu 
- Base DS14 w/AC Pwr Supplies 
- DS14 LS Module Cu-Cu Ports 
- TERMINATOR FC-AL 
- 36(34)GB FC DISK FOR DS14 
- STRG, CARR, SUBASSY-SHORT, DS14 
- Quad 10/100Base-T Adapter 
- LVD/SE 2-Chnl SCSI Adapter 
- AC CORD W FERRITE N. AMERICA 
- F810 Install 
- NetApp HDW Support, F810 SN ON LINE 1 
- SW Sub F810 
 
Ils-ghost 
 
Ils-ghost is the server that has SILS deployment solution software called 
Altiris for Windows and Linux clients.  Its IP address is 152.2.81.17 
 
- Microsoft Windows 2000 Advance Server 
- Version 5.0.2195 Service Pack 3 Build 2195 
- Gateway E-4600 x86–based PC 
- X86 Family 15 Model 0 Stepping 7 Genuine Intel ~ 1396 Mhz 
- Bios Version 11/17/00 
- Total Physical Memory 261, 424 KB 
- Available Physical Memory 115,588 KB 
- Total Virtual Memory 894,072 KB 
- Available Virtual Memory 470,368 KB 
- Page File Space 632,648 KB 

mailto:ADAMS@ILS.UNC.EDU
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Owl 
 
Owl is the server that runs Cold Fusion, IIS, and a Ftp server.  Its IP 
address is 152.2.81.9 
 
- Microsoft Windows 2000 Server 
- Version 5.0.2195 Service Pack 3 Build 2195 
- Dell Dimension 8200 x86-based PC 
- X86 Family 15 Model 1 Stepping 2 Genuine Intel ~ 1794 Mhz 
- Bios Version 12/7/01 
- Total Physical Memory 261,136 KB 
- Available Physical Memory 59,512 KB 
- Total Virtual Memory 893,140 KB 
- Available Virtual Memory 419,280 KB 
- Page File Space 632,004 KB 
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4. Functional operations in the office 
 
  Shawn Jackson 
 

Applications: Microsoft Word, Excel, Mulberry, and the Internet. 
 
Occasionally: PowerPoint, Corporate Calendar. 
 
Services: ADVISE (University database) 
 
Storage: saves all files to G: drive 

 
Job responsibilities:  

Director of Development - She manages Alumni, 
Corporate and Foundation Relations for SILS.  
Building relationships with these audiences and 
soliciting gifts (of money and services/equipment) is 
another responsibility of hers.  She interacts with 
students (student organizations and individuals) on 
projects/events and with faculty or funding for 
research and service projects/events. 

 
Contact Information:   

Home -  6724 EASTBROOK DRIVE 
RALEIGH, NC 27615 
H - 919-844-9066 
C - 919-622-5332 

 
Work -  Shawn D. Jackson 

Director of Development 
School of Information and Library Science 
University of North Carolina at Chapel Hill 
Campus Box 3360, 101 Manning Hall 
Chapel Hill, NC 27599-3360 
(919) 962-8365 
fax (919) 962-8071 
shawn_jackson@unc.edu 
 

Susan Thomas 
 
Applications: Microsoft Outlook (for email), Excel (internal  
 account databases), Internet Explorer (university sites) 

 
Occasional Applications: Microsoft Publisher 
 
Services: 

mailto:shawn_jackson@unc.edu


 45

Finance Central - Used for check requests, deposits, 
electronic account reports, Information Technology 
Purchasing System, Financier 
 
ADP - (Hummingbird Host Explorer) Used to do budget 
revisions, check account balances, process personnel 
transactions, BD-119 salary increase system, EPA position 
control, access payroll check register. 
 
PR Assist  - System used to do online purchase orders 
 
HRIS (Human Resource Information System)  - Used for all 
SPA, student and temp personnel transactions. 

 
Job Responsibilities:  

Administrative Manager -  purchasing, payment of all 
invoices, personnel and payroll, and budgets 

 
Contact Information: 

Home -  170 Offset Farm Road 
Sanford, NC  27332 
919-962-0182  (Work) 
919-258-6966  (Home) 

 
Work - Susan Thomas 

Administrative Manger 
School of Information and Library Science 
University of North Carolina at Chapel Hill 
Campus Box 3360, 101 Manning Hall 
Chapel Hill, NC 27599-3360 

  (919) 962-0182 
Fax (919) 962-8071 
thomas@ils.unc.edu 
 

 
Angie Heinisch 

 
Applications: Email, MS Office, Corporate Time, Facility Services 

- http://www.fac.unc.edu/ 
 
Occasionally: Adobe Acrobat, Photoshop, Dreamweaver, FTP, 

Classroom reservations 
http://www.ils.unc.edu/html/4_resource_res.shtml 

 
Services: HRIS, ADVISE, ADP 

 
Contact Information:     

mailto:thomas@ils.unc.edu
http://www.fac.unc.edu/
http://www.ils.unc.edu/html/4_resource_res.shtml
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Home - Angela Heinisch 
4304 New Brighton Drive 
Apex, NC 27539 
919-280-7171 

 
Work -  Angie Heinisch 

School of Information and Library Science 
University of North Carolina at Chapel Hill 
CB# 3360, 102 Manning Hall 
Chapel Hill, NC  27599 
(919) 962-8363 
(919) 962-8071 (fax) 
heinisch@ils.unc.edu 

 
Lucia Zonn 

 
Applications: Microsoft Word, ACCESS Database, Microsoft 

Outlook, Student Information System (UNC student data 
base), Faculty/Staff Central (web interface to UNC student 
database), OWL? ORCLE? (SILS graduate application) 

 
Occasionally:  EXCEL 

 
Storage: Saves Word and Excel to D drive.  Saves Access to G, 

Owl to G. 
 

Job Responsibilities:   
Student Services Manager - Oversees student services, 
including graduate admissions, enrollment, registration, 
comprehensive exams, master’s papers and graduation.   

 
Contact Information: 

Home –  104 Stonehill Road 
Chapel Hill NC 27516 
H 919-942-0628 
lzonn@nc.rr.com 

 
Work – Lucia Zonn  

Student Services Manager 
School of Information and Library Science 
University of North Carolina at Chapel Hill 
Campus Box 3360, 100 Manning Hall 
Chapel Hill, NC  27599-3360 
919-962-7601 
fax 919-962-8071 
zonn@ils.unc.edu 

mailto:heinisch@ils.unc.edu
mailto:lzonn@nc.rr.com
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Marcia Tauber 
  

Applications:  Microsoft Word, Excel, and the Internet. 
  

Storage:  saves all files in D: drive 
  

Job responsibilities: 
Office Assistant – Responsible for helping faculty members 

in a variety of tasks, i.e., ordering textbooks, keeping 
copies of syllabi, helping with mailings, etc.  I'm 
responsible for following through on the AAIRB 
process for students and making sure that they meet 
university guidelines.  I keep the office copy of the 
alumni directory updated, as well as the job 
opportunity book in the SILS library.  I monitor, order 
and distribute office supplies for SILS and am 
responsible for typing and following up on all travel 
vouchers for faculty, adjuncts and teaching assistants.  
I've also been handling the SIR II evaluations for all 
faculty members. 

  
  

Contact Information: 
Home:     105 Anglese Court,  

Chapel Hill  
NC 27516 

 
Work:     Office Assistant,  

School of Information and Library Science, 
University of NC at Chapel Hill,  
CB# 3360  
100 Manning Hall 
Chapel Hill NC 27599-3360 
919 962-8367. 

  
Cheryl Lytle 

 
Applications: SILS lab supported apps, 

http://ils.unc.edu/ils/silslab/html/sw.shtml,  UNC supported 
Apps; https://shareware.unc.edu/software.html 

 
Storage: All types of media, 

http://ils.unc.edu/ils/silslab/html/how_to_backup.shtml 
 

Job Responsibilities: 
Principal Functions:  

http://ils.unc.edu/ils/silslab/html/sw.shtml
https://shareware.unc.edu/software.html
http://ils.unc.edu/ils/silslab/html/how_to_backup.shtml
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• Fosters and advocates the incorporation of 

leading-edge technology into the school’s 
curriculum by supervising the 
implementation of technologies such as 
Internet instruction tools, Internet 
collaboration tools, ubiquitous computing, 
and multimedia applications. 

 
• Teaches formal and informal courses as 

necessary in the area of IT. 
 
• Supports faculty and students by offering 

individualized consultation, lab 
demonstration sessions, and short courses on 
specific software applications. 

 
• Instructs and assists faculty with the 

incorporation of information technologies 
into their courses. 

 
• Plays a key role in the computing 

infrastructure for the school’s undergraduate 
minor in Information Systems and in the 
computing support of all undergraduates 
using the computing labs. 

 
• Develops curriculum and computer lab 

support materials and documentation such as 
web pages, demonstrations, and exercises. 

 
• Insures reliable and functional operation of 

Unix and NT based systems and components 
and supervises system changes and updates 
as necessary. 

 
• Oversees the daily operation of the school’s 

student computing laboratories including 
training and supervision of student lab 
assistants and student lab managers, and the 
integration of student laptops into the 
School’s computing infrastructure. 

 
• Supervises the development of appropriate 

policies and procedures for systems and 
facility management including security, 
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backup, and resource allocation for Unix 
and Windows computing environment. 

 
• Remains aware of current trends and 

changes in information technology and 
works with faculty to insure that the 
curriculum reflects those trends and 
changes. 

 
• Recommends hardware and software 

purchases from an annual budget of 
approximately $200,000 for academic 
technology to the school’s Director of 
Information Technology. 

 
• Participates in departmental and campus 

wide computing forums and committees. 
 
• Executes special projects and assignments at 

the discretion of the Director of Information 
Technology. 

 
Contact information: 

Home -  4707 Carlton Crossing Drive 
Durham, NC 27713 
919 408-0391 

 
Work -  SILS Lab 

114 B Manning Hall, CB #3360 
Chapel Hill, NC 27599 
clytle@email.unc.edu 
919 843-9282 

 
Rebecca Varga 

   
Applications: MS Office (Word, Access, Excel, Outlook), Web 

editors-Dreamweaver, Email-Outlook and Mulberry, 
Photoshop, Adobe Acrobat 

 
Storage: D, G, L drives, Ruby, Kiwi, Owl (Master's Papers 

Database), Shared H Drive (Davis Library),  Library 
Systems  ( through Davis Library), DRA, INNOPAC 
LARS, E-databases and indexes (there are over 500 
databases), i.e. OCLC WorldCat,           
http://eresources.lib.unc.edu/eid/ 

 

mailto:clytle@email.unc.edu
http://eresources.lib.unc.edu/eid/
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Job responsibilities: 
SILS Librarian: The SILS Librarian is responsible for 

overall management of the library, including 
collection development and management, liaison with 
departmental faculty and the central library, facilities 
and equipment planning, and reference and research 
assistance.  The SILS Librarian oversees the work of 
one paraprofessional staff member, a research 
assistant, and several student assistants.  The librarian 
serves on library-wide committees and task forces and 
reports to the Associate University Librarian for 
Public Services. 
 

Contact Information: 
Home:             10 Cedar Hill Drive 

Durham, NC  27713 
(H) 919-544-6045 
stephen.vargha@verizon.net 

 
Work: Rebecca B. Vargha, Librarian 

School of Information and Library Science 
University of North Carolina at Chapel Hill 
115B Manning Hall CB# 3360 
Chapel Hill, NC 27599-3360 
Phone:  919-962-8361 
Fax:    919-962-8071 
Email:  vargha@ils.unc.edu 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

mailto:stephen.vargha@verizon.net
mailto:vargha@ils.unc.edu
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5. Backup Server Recovery (Disaster) – Server/Image  
 
  The Backup Server and Library 

 
Onyx, the backup server, is a Sun Microsystems Enterprise 250 
machine running Solaris 2.8 with version 6 Solstice for Unix, 
Network edition.  The Networker for Unix Network edition came 
as part of the package; however, it only allowed 10 machines to 
connect at a time, which is not sufficient for our school.  Two extra 
modules of Networker Client Connection were purchased, each 
allowing 25 connections giving us a total of 60 connections at a 
time.  In addition, modules for each type of Operating System, that 
would need to be backed up, were purchased – Client for Linux, 
Client for Unix, and Client for Windows.  

 
The Library is a Sun Microsystems StorEDGE L1000 and it was 
made by ATL (Automated Tape Library).  It is connected to Onyx 
via a differential SCSI cable and contains two DLT 7000 drives (it 
has the capacity to hold four drives) that cost approximately $5100 
each. 

 
Back up Process 

 
The Library stores 30 DLT tapes, which are used to backup the 
data for SILS.  Backup is separated into two groups: Schedback 
and Schedlaptop.  Each group has their own tapes and these tapes 
can only be used to backup machines from their respective groups, 
example, DLT C#### can only be used to back up laptops.  In the 
Library are 27 tapes for Schedback, 2 tapes for Schedlaptop, and a 
cleaning tape 
 
The Schedlaptop group comprises of faculty and staff’s laptops 
and Schedback has all faculty and staff’s desktops.  These groups 
were devised since different machines are backed up at different 
times and with different sequences (full backups or incrementals). 
Every Friday, the DLTs with the newest data are removed from the 
Library and stored in racks in Scott’s office.  It has been Scott’s 
practice to remove 14 tapes with the most recent backups every 
Friday; this provides enough tapes for a full week of backups.  
Tapes that were removed two weeks prior, allowing up to 2 weeks 
to be recovered at all times replace these tapes. 
 
All backups are logged on Onyx, in addition, Onyx send daily 
email notifications to Scott showing all the machines that were 
backed up successful and those that were unsuccessful (the 
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bootstrap notification).  Here is a list of Preconfigured 
Notifications that are available from the Networker server 

  
Notification NetWorker Response 
Bootstrap Prints the bootstrap information on the 

NetWorker server’s default printer. 
Cleaning cartridge 
expired 

Sends e-mail to root: replace the expired 
cleaning cartridge 

Cleaning cartridge 
required 

Sends e-mail to root: insert a cleaning 
cartridge. 

Device cleaned Sends e-mail to root: device cleaning is 
complete. 

Device cleaning 
required 

Sends e-mail to root: clean the device. 

Device disabled Sends e-mail to root: a device has been 
automatically disabled. 

Index size Sends e-mail to root: check the size of the 
client file index because it will soon exceed 
the space available. 

Log default Directs the UNIX syslog facility 
(/usr/bin/logger) to log information from 
the /nsr/logs/messages file into the 
appropriate system log file. 

Migration attention Sends e-mail to root: check the status if a 
migration operation. 

Migration 
completion  

Sends e-mail to root: a migration operation 
is complete. 

Registration Sends e-mail to root: check the registration 
status 

Savegroup 
completion 

Sends e-mail to root: degree of success in 
completing scheduled backups, cloning, 
and archive operations. 

SNMP notification 
request 

Sends notification through the configured 
trap. 

Tape mount request 
1 
Tape mount request 
2 
Tape mount request 
3 

Requests media be mounted in a device 
and: 
4 Displays a pending message. 
5 Sends e-mail. 
6 Logs a message to syslog. 
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Backup Schedule for Machines at SILS 
 
Type of Machine Full Backup Incrementals 

Faculty Wednesdays at 
7:30 pm. 
(Including PHD 
machines and 
Library 1,2,3) 

Everyday PCs 

Staff Fridays at 4:00 am Everyday 
Win Servers Sundays at 12:01 

am (Falcon, Kiwi, 
Pelican, Guinea, 
Hawk, Owl – only 
c:\inetpub) 

 

Sun Fridays at 10:00 
pm (except Pearl 
and Jade – full 
backups on 
Tuesday) all 
partitions are 
backed up.  All  

 

Linux Mondays at 2 am Everyday 
Laptops (Professors) Thursdays at 6:00 

pm 
No 
incrementals 

 
 
 

Onyx 
 

Onyx needs to have these five process running for it to be 
considered “up and running”, and they are nsrd, nsrmmdbd, 
nsrexed, nsrindexd, and nsrmmd. 

 
Daemon/Program Function 
nsrd This daemon provides an RPC-based save and 

recover service to NetWorker clients; master 
NetWorker daemon. 

nsrmmdbd This daemon provides media and save set 
database management services to the local nsrd 
and nsrmmd daemons and records entries in the 
media database; media management database 
daemon. 

nsrexed  
nsrindexd This daemon provides a method for inserting 

entries in the client file index based on 
information passed by the save program 
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nsrmmd This daemon provides device support, generates 
mount requests, and multiplexes save set data 
during a multiclient backup (nsrd can start 
several nsrmmd daemons, up to the number 
specified in the device’s Target Sessions 
attribute); media multiplexor daemon. 

 
To start all services – logged in as root type 
/etc/rc3d/S95networker start 
To stop all services – logged in as root type nsr_shutdown 

 
From home – log into Onyx and type nsrwatch 

 
Groups: 

 
The Group resource, also known as backup groups, is a resource 
that specifies a specific time of the day when a backup occurs.  
Typically backup times are scheduled after regular work hours, 
such as late evenings and on the weekends.  These times are 
preferred so that the heavy network traffic load associated with 
backups does not interfere with regular work activities.  Any client 
assigned to a specific group will have its specified save sets backed 
up during that time. 

 
Pool: 

 
A pool is a specific collection of media to which the NetWorker 
server writes data.  The NetWorker server uses pools to sort and 
store data.  The configuration settings for each pool act as filters 
that tell the server which volumes should receive specific data.  
Pools are used in conjunction with label templates to keep track of 
which data is on which specific volume. 

 
Indexes: 

 
Every time the NetWorker server backs up a file to media (for 
example, magnetic tape), it creates an entry for the file in an index. 
The NetWorker server uses this index to map the backed-up files 
to volumes 

 
Backup types explained: 
 

• Full backup backs up all files, regardless of whether or not they 
have changed. 

• Incremental backup backs up files that have changed since the 
last backup, regardless of level. 
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• Level [1-9] backup backs up files that have changed since the 
last lower numbered backup.  For example, a level 1 backup 
backs up the files that have changed since the last full backup 
(considered a level zero).  A level 3 backup backs up all the 
files that have changed since the last level 2 backup, level 1 
backup, or full backup.  A level 9 backs up all the files that 
have changed since the last level, 8,7,6,5,4,3,2,1, or full (0) 
backup. 

 
Schedules: 

 
The Schedule resource provides the ability to specify the day of the 
week and date during the month when the backup occurs.  The 
type and nature of the backup is also specified in this resource.  
Because scheduled backups are configured in terms of weekly or 
monthly, the type of backup scheduled for a specific day of the 
week is in turn duplicated for: 

• The same day in each subsequent week. 
• The particular day of a particular week once each week. 

 
 

Legato Software Management GUI 
   

Legato NetWorker provides a solution for network storage management; it 
protects and helps manage data across an entire network of computers.  
The NetWorker software saves valuable administrator time by speeding up 
and simplifying daily operations of storage management.  The GUI guides 
you through administering and configuring your network for storage 
management.  As the NetWorker software manages your data, it creates a 
database of saved data, making it easy to locate data for recovery.   

 
How to create a pool: 

1. Determine a label template for you pool. 
2. Select Media>Pools to open the Pools window. 
3. Click create. 
4. Enter a name for the pool in the Name attribute.  This name 

must match either a label template you created beforehand, or 
one of the default templates. 

5. Select Yes from the Enabled attribute. 
6. Select the appropriate pool type from the Pool Type attribute. 
7. Select the matching label template in the Label Template 

attribute. 
8. Select the groups associated with this pool in the Groups 

attribute. 
9. Enter the names of clients associated with this pool in the 

Clients attribute. 
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10. Enter the save sets associated with this pool in the Save Sets 
attribute. 

11. Select the backup levels associated with this pool in this Levels 
attribute. 

12. Select the devices that are permitted to mount volumes 
associated with this pool. 

13. Select whether or not client file index entries are generated for 
this pool in the Store Index Entries attribute. 

14. Select whether or not automated media verification will be 
performed while data is written to a volume associated with 
this pool in the Auto Media Verify attribute.  

15. Select whether or not volumes marked as recyclable can be 
used by other pools in the Recycle to Other Pools attribute. 

16. Select whether or not this pool can recycle volumes from other 
pools in the Recycle from Other Pools attribute. 

17. Select a preference for volume type in the Volume Type 
Preference attribute.  The value you state is used as a selection 
factor when a request is made fro a writeable volume. 

18. Complete any other attributes as necessary, and click Apply.  If 
any of these settings for a new pool match an existing pool, 
you receive the following warning message: Pool pool_name 
has overlapping selection criteria. 

 
How to create a Group: 

1. Select Customize>Groups to open the Groups window. 
2. Click Create. 
3. Enter the name of the group in the Name attribute.  Do not 

include spaces in a group name. 
4. Select Enabled from the Autostart drop-down list. 
5. Enter a new time in the Start Time attribute, unless you want to 

keep the default time of 3:3 a.m.  Note: When you select a start 
time for your different groups, make sure you schedule them 
far enough apart so that one group has completed backing up 
before the next group starts. 

6. Enter or select a number in the Client Retries attribute.  This 
value specifies the number of times the NetWorker server will 
attempt to back up a failed client. 

7. Select Yes in the Clones attribute to automatically clone the 
group’s backed-up data.  If you select No, do not complete the 
subsequent clone-related tasks in the subsequent steps and skip 
to step 10. 

8. Select the appropriate clone pool for the cloned data in the 
Clone Pool attribute (requires cloning to be enabled). 

9. Select the appropriate migration clone pool in the Migration 
Clone Pool list (requires cloning to be enabled). 
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10. Enter the name of the printer on which savegrp will print the 
bootstrap save set information in the Printer attribute. 

11. Complete any other attributes as necessary and click Apply. 
 

How to schedule a group: 
1. Select Customize>Groups to open the Groups window. 
2. Select View>Details to display the Group resource’s hidden 

attributes. 
3. Enter the interval attribute value in hours, using hh:mm format, 

and click Apply. 
 

How to Start Groups Immediately: 
When you start a schedule backup group manually (on demand), 
the NetWorker server runs the backup at the level of the next 
scheduled backup, which can be full, level 1-9, consolidated, or 
incremental. 
 
To start group immediately: 
1. Select Server>Group Control or click the Group Control 

toolbar button to open the Group Control window. 
2. Select the name of the group you want to start immediately in 

the Groups attribute. 
3. Click Start to initiate the group backup. 
 
When you start the group in this manner, the NetWorker server 
overrides the groups’ scheduled start time and immediately backs 
up the clients in the group. 

 
How to Create Clients 

Before a client can be backed up be a NetWorker server, the client 
computer must have the appropriate NetWorker client software 
installed.   
 
If you choose not to customize the configuration choices, the new 
NetWorker client is automatically assigned the default 
configuration.  The default setting All for the Save Set attribute 
means that all the files on the client are backed up during a 
scheduled or manual backup. 
 
Note: For UNIX clients, setting the Save Set attribute to All will 
not back up all locally mounted file systems.  The only file systems 
backed up will be those listed in the following locations: 
• Solaris and Sequent: /etc/cfstab 
• HP-UX, Compaq Tru64, Linux, and SGI: /etc/fstab 
• AIX: /etc/filesystems   
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To create a client: 
1. Select Clients>Client Setup to open the Clients window. 
2. Click Create 
3. Enter the client’s new hostname in the Name attribute 
4. If you installed the Archive Application, the Archive Services 

attribute is disabled 
5. Select a schedule in the Schedule attribute 
6. Select a browse policy in the Browse Policy attribute.  A 

typical default choice is Quarter 
7. Select a retention policy in the Retention Policy attribute.  A 

good choice is Year. 
8. Select a directive in the Directives attribute 
9. Select a group in the Groups attribute to which your client will 

be added. 
10. Enter the save sets that you want backed on this client in the 

Save Set attribute. If you want all the saves sets backed up, 
enter All. If you need to back up large client filesystems, you 
may want to schedule each filesystem to back up separately.  
For example, you might create two separate clients with the 
same name, but with different save sets. 

11. Enter the user ID or hostnames of other clients that are allowed 
to back up or recover this client’s files in the Remote Access 
attribute.  Leave this attribute blank if you only want this client 
to have those rights. 

12. Enter the user ID of a client to allow remote access and 
operations on this client in the Remote User attribute.  The 
Password attribute is only used for computers running 
NetWare.  The password entered in this attribute is used to 
perform remote commands on this client. 

13. Enter the savepnc command, or the name of a program file you 
created that includes commands to execute before and after the 
NetWorker software backs up client data, in the Backup 
Command attribute. 

14. Enter the nickname(s) for the client computers that queries can 
match in the Aliases attribute.  Otherwise, queries match only 
the client name. 

 
How to Label and Mount a DLT 

1. Apply the bar code on DLT 
2. Insert an unlabeled or recyclable tape in the Library 
3. Select the appropriate device (DLT) in the Devices list of the 

NetWorker Administrator program. 
4. Select Media>Label of click the Label toolbar button to open 

the Label Window. 
5. Check the Mount After Labeling attribute and click OK. 
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The NetWorker server automatically labels the volume and then 
amounts the volume into the device. 

 
 

L1000 or jukebox 
 

The Sun StorEdge L1000 is an automated digital linear tape (DLT) library 
system consisting of up to four DLT7000 tape drives and 30 tape cartridge 
bins.  The maximum storage capacity of the library is 1050 gigabytes each 
(up to 70 gigabytes compressed). 

 
Control Panel Uses  

 
• To turn the Library On (44) 
• To turn the Library Off (45) 
• To place the Library On-line (44) 
• To place the Library Off-line (45) 
• To Insert Tape Cartridges (45) 
• To Open the Library Doors (47) 
• To Manually Eject a Cartridge (47) 
• Operator Commands 

• To configure Library Attributes (53) 
• To configure Library Options (55) 
• To move a cartridge (57) 
• To perform an Inventory (58) 
• To calibrate the Library (59) 
• To exercise the Library (60) 
• To unload a Drive (61) 
• To unload a load port 

• Service Commands  
• Generating Reports (65)  
• Testing the Library (68) 
• To perform a system test (68) 
• Initializing Nonvolatile Information (70) 
• To Execute Nonvolatile Memory Commands (70) 
• To Change a Password (71) 

  
 

To Turn the Library On 
 

1.  Be sure of the following: 
• All internal packaging is removed. 
• The front doors and load port are closed. 
• The library enclosure is installed. 
• All back panel connections are secure. 
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2.  At the front panel, set the AC power switch to the | (on) 

position.  After several second, verify that control panel comes 
on. 

 
To Turn the Library Off 

 
1.  Press the Standby button. 

Verify that the library completes the current command and then 
goes off-line. 

2.  Make sure the gripper is empty by checking the Overview 
control panel screen.  If the gripper has a tape cartridge, use the 
Move Cartridge command to move the cartridge to a storage 
bin or load port. 

3.  Set the AC power switch to the O (off) position. 
     Verify that the control panel turns off.  

 
To Manually Eject a Cartridge 

 
Occasionally, you may need to unload and eject a tape cartridge 
using the controls on the front panel of the tape drive. 
 
1.  Open the library doors. 
2.  Remove the load and bulk from the front of the library. 

a. Press the latch at the top of either pack. 
b. Grasp a handle and gently pull the pack 

while pressing the release latch at the 
bottom of the pack. 

c. Repeat Step a and b to remove the other 
pack. 

3.   Press the Unload button on the drive and wait for the Operate 
Handle indicator to light. 

 Note – When you press Unload, the tape cartridge rewinds.  
Depending in the tape cartridge position, this may take between 
10 to 120 seconds.  When the rewind process is completed, the 
Operator Handle indicator lights. 

4.  When the Operator Handle indicator lights, raise the 
insert/release handle to eject the tape cartridge. 

5.  Pause for two seconds, then grasp the tape cartridge and slowly 
pull it one-half way out of the drive. 

6.  Examine the tape cartridges to see whether all of the tape media 
has been rewound into the tape cartridge. 

  If the tape cartridge leader failed to detach from the take-up 
leader, push the tape cartridge all of the way into the drive, 
press down the insert/release handle, and return to Step 4.  
Otherwise, continue to Step 7. 
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7.  Pull the tape cartridge completely out of the drive. 
8.  Reinstall the load and bulk packs by reversing the removal 

procedures in Step 2 
 Be sure to line up the guides on the top and bottom of the load 

packs with the mounting blocks on the frame. 
9.  Close and lock the library doors. 

 
Performing an Inventory 

 
The Inventory command records the bar code labels of the 
cartridge in the tape drives, fixed storage bins, load pack bins, and 
the load port.  Library elements that contain cartridges without 
labels will be marked full with no label. 
 
• Press the Inventory Tapes button in the Operator screen. 
 
A “Command In Progress” screen appears.  The inventory process 
continues until all storage elements have been checked or you stop 
the process by pressing the Abort button in the screen. 

 
 

Data Backup and Recovery 
 

This section describes the method for backing up your data manually, 
rather than using the scheduled group backup method. It also details 
the various methods for recovering backed-up data, and how to direct 
recovered data to the location of your choice. 

 
Manual Data Backups 

 
The NetWorker server backs up your client data regularly using 
scheduled backups. Scheduled backups are the preferred backup 
method because they occur automatically, and also because 
scheduled backups can be recovered more easily. 
 
Manual backups are intended for quick backups of a few files 
initiated by a user. They do not generate bootstrap files or back up 
indexes, so they cannot replace scheduled backups. Remember that 
you can manually start a scheduled backup group at any time by 
selecting the Start Group command. 
 
There may be times, however, when you want to back up one or 
more data items to the NetWorker server right away, instead of 
waiting for the scheduled nightly backup. For example, if you have 
just finished working on a spreadsheet, you might like to back the 
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file up right away. 
 

How to Manually Back Up Data 
 

The nwbackup program provides a graphical interface through 
which you can perform manual backups.  

 
The nwbackup program is used to perform a manual backup 
initiated from the client rather than from the server’s scheduled 
group backup (savegrp) that includes the client. 

 
To start a manual backup: 

1. Start the nwbackup program by entering the following 
command at the prompt: 
# nwbackup -s server 
Use the -s server option to specify a particular NetWorker 
server on the network. 
The nwbackup program displays a representation of the 
client’s filesystem. 

2. Mark each directory and/or file for manual backup by 
selecting it and 
performing one of the following tasks: 

– Selecting the item and clicking the Mark toolbar 
button, 

– Clicking the “mark” box next to each item listed, 
– Selecting Mark>Mark. 

When you mark an item for backup, a checkmark appears 
next to that item. 
 
You can unmark a marked item in a similar way by 
selecting the item and performing one of the following 
tasks: 

– Selecting it and clicking the Unmark toolbar button. 
– Clicking the checked “mark” box next to the item to 

remove the checkmark. 
– Selecting Mark>Unmark. 

You can designate the entire filesystem, specific 
directories, or individual files for manual backup. If you 
select a directory for backup, all of its nested subdirectories 
and files are also selected for backup. If you want to 
exclude certain files from manual backup, you must 
deselect those items. 

3. Select File>Start Backup or click the Start toolbar button to 
begin the manual backup. 

 
If you do not see the directories and files you requested for 
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backup appearing in the Manual Backup Status dialog box, 
or if you receive a message such as the following: 

 
Waiting for Server and there is no apparent backup activity, 
the NetWorker server might not recognize your client, or 
there might not be a volume mounted in the storage device. 
You can end the backup by clicking Cancel. 

 
 ______________________________________________________ 

Important: Sometimes there are bad files or errors on computer 
disk volumes that the NetWorker server cannot detect during a 
backup. It simply backs up the bad data. It is a good idea to run 
diagnostic programs regularly on your computers to correct disk 
volume errors. 
______________________________________________________ 

 
Data Recovery 

 
Recovery of backed-up data is performed using the nwrecover 
program.  
 
Every time the NetWorker server backs up a file to media (for 
example, magnetic tape), it creates an entry for the file in an index. 
The NetWorker server uses this index to map the backed-up files 
to volumes. If your computer has not been backed up yet, you will 
see an error message when you try to recover data. 
 
Using nwrecover, you can browse backed-up files and filesystems 
from NetWorker clients and recover files as they were at a specific 
point in time when they were backed up. The versions of files and 
filesystems available in the nwrecover are determined by the time 
period specified in the browse policy.  
 
If remote access is enabled, users may also be able to recover files 
from other client computers.  
 
When recovering data onto a filesystem where other versions of 
the same data already reside, there is the likelihood of a file 
conflict. You can determine what course of action to take each and 
every time a conflict occurs during a recovery, or you can instruct 
the NetWorker server in advance what action to take for all 
conflicts, You can also simply redirect the recovered data to a 
different directory where there is no danger of conflicts. 

 
How to Recover Data 

 



 64

To recover data: 
1. Start the nwrecover program by entering the following 

command at the prompt: 
 # nwrecover -c client -s server 
 Use the -s server option to specify a particular NetWorker 

server on the network. Use the -c client option to specify a 
particular NetWorker client on the network. 

 The nwrecover program displays a representation of the 
client’s filesystem. 

2. Determine how you want the NetWorker server to handle one 
of these conflicts: 
a. Cases where there is a conflict between a recovered file and 

one that already exists on the filesystem of the client 
receiving the recovered data. 

b. If you want the recovered data to be relocated to a different 
directory than the one it originally existed in at the time of 
the backup. 

3. Mark each directory and/or file for manual backup by selecting 
it and performing  one of the following tasks:  
a. Selecting the item and clicking the Mark toolbar button, 
b. Clicking the “mark” box next to each item listed, 
c. Selecting Mark>Mark. 

 When you mark an item for backup, a checkmark appears next 
to that item. 

 You can unmark a marked item in a similar way by selecting 
the item and performing one of the following tasks: 
d. Selecting it and clicking the Unmark toolbar button. 
e. Clicking the checked “mark” box next to the item to 

remove the checkmark. 
f. Selecting Mark>Unmark. 

 You can designate the entire filesystem, specific directories, or 
individual files for recovery. Note that if you select a directory 
for backup, all of its nested subdirectories and files are also 
selected for recovery. If you want to exclude certain files from 
recovery, you must deselect those items. 

 Note: if you want to recover data from a scheduled backup 
other than the most recent one, then you must change the 
browse time.  

4. Select File>Start Backup or click the Start toolbar button to 
begin the recovery. 

 It takes the NetWorker server a few moments to recover your 
file, depending on file size, network traffic, server load, and 
tape positioning.  During this time, messages appear for each 
recovered file in the nwrecover program, so you can monitor 
the progress of the recovery. 

 If there is a naming conflict with the file you are recovering, 
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the NetWorker server prompts you to choose one of several 
workarounds.  

 
  If the recovery is successful, the nwrecover program will 

display the following (or a similar) message: 
 
 Successfully received 1 file 
 
 Recovery completion time: 5-30-97 2:03p 

 
How to Recover Data from a Previous Backup Time 

 
Using the nwrecover program, you can browse the entries for each 
backed-up file listed in the client file index created at any time you 
specify. Changing the browse time allows you view the entries for 
your backed-up files for a particular period. You might want to do 
this if you need to: 
•  Look for an item that you know you had previously, but is now 

gone. 
•  Retrieve an earlier version of an existing item. 
Your browse policy determines how long older data is retained and 
thus, your ability to browse and recover this data. For example, if 
you would like to recover a lost file that you backed up six months 
ago, your browse policy must support it.  
 
To recover data from a previous backup time: 
1. Select Change>Browse Time to open the Change Browse Time 

window. 
 The Change Browse Time window displays a monthly calendar 

from which you can select the client’s backup. Click Previous 
or Next for earlier or later months. 

2. Select the month and day that corresponds to the client data 
you want to recover. 

3. Edit the time and date listed in the Browse Time attribute if 
you want a browse a time other than the one displayed. 

4. Click OK. 
5. The Change Browse Time window disappears, the nwrecover 

program now displays your client’s file system as it appeared 
on the day and date you selected. The nwrecover program also 
displays that date in the Browse Time attribute. 

6.  Select the items you want to recover. 
 
 

How to Relocate Recovered Data 
 
When you recover data, the NetWorker server copies the data from 
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the volume to a location on your computer. Unless you relocate the 
recovered data, the server tries to place the files in the original 
directory created when the data was last backed up. If an existing 
data item on your local disk has the same name as the one being 
recovered, the server will prompt you for instructions on how to 
recover the data item (rename, overwrite, or discard). 
 
You can instruct the NetWorker server where to relocate the 
recovered data item in advance of the recovery using the Relocate 
feature while in the nwrecover program. Enter the new recovery 
destination path in the Relocate 
To attribute of the Recover Options dialog box. 
To relocate recovered data: 
1. Select Options>Relocate to open the Relocate window. 
2. Enter the new directory location in the Relocate To attribute 

and click OK. 
 
You must provide the full pathname of the relocation directory. 
The recovered data will automatically be relocated to the directory 
you entered. 

 
How to Resolve Recovered Data Conflicts 

 
By default, when the NetWorker server recovers data it will 
attempt to return them to their original location, using their original 
file and directory names. However, if another file or directory with 
the same name is present in that same location, a file recovery 
conflict will occur. You can instruct the NetWorker server to 
respond to these recovery conflicts in several different ways, either 
on an item-by-item basis, or automatically. 
 
You are prompted to make conflict resolution decisions each time 
to start a recovery using the nwrecover program. When you start 
the recovery, the Conflict Resolution window appears and asks you 
if you want to be prompted when a conflict occurs. 
 
If you select Yes in the Conflict Resolution window, then each time 
there is a conflict, the NetWorker server will prompt you to select 
a resolution options.  
 
If you select No in the Conflict Resolution window, then you must 
enter an automated conflict resolution option that the server will 
follow each time there is a conflict during the recovery. 
 
This table lists the conflict resolution options available during a 
recovery. 
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Recovery Options 
Option Action 
Rename the Recovered 
File 

Renames the recovered files by 
inventing a unique name that closely 
resembles the original name.  
Typically, the new name is the 
original name prefaced with a tilde 
(~). 

Discard the Recover File Discards the recovered data in order 
to prevent NetWorker from 
recovering the file if there is another 
file with the same name on your 
filesystem. 

Overwrite the Existing 
File 

Replaces the data on your filesystem 
with the recovered version. 

 
You can also choose to relocate your recovered data to a different 
directory where you know there will be no conflicts, or create a 
new directory using the Relocate feature. However, even if you 
relocate your recovered data to a new and/or empty directory, the 
NetWorker server still prompts you to enter your conflict 
resolution information.  

 
How to Search for a Recoverable File 

 
You can search for a file and directory you want to recover, but 
cannot locate in the nwrecover program, by using the Search 
feature. The Search feature allows you to enter the name of the 
item you are seeking, as well as the directory where the search will 
begin. This is handy if you want to speed the search by limiting the 
locations to be searched. 
 
To search for a recoverable file: 
1. Select View>Search to open the Search window. 
2. Enter the name or a partial name of the item you are seeking. 
3. Enter a path to designate where the search will begin. The 

default value is root (/), which will instruct the NetWorker 
server to search the entire filesystem. 

 
How to View Details of Recoverable Files 

 
You can display the contents and other details of directories listed 
in the left pane of the nwrecover window in the right pane using 
the File Details feature. 
 
When the File Details feature is enabled, the nwrecover program 
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displays detailed information regarding the files and subdirectories 
of the selected directory, including the date and time the file was 
last backed up, the permission of the file, and the date created. 
 
To view details of recoverable files:  
1. Select the item whose content’s details you want to view. 
2. Select View>File Details to display this information. 

 
How to View the Version Details of Backed-Up Data 

 
You can view the back-up details of a directory or file you select in 
the 
nwrecover program using the Version feature. The Versions 
feature provides a listing of each time the NetWorker server 
backed up that file, including the day, date, time, and size. 
 
To view the version details of backed-up data: 
1. Select the item whose backup version you want to view. 
2. Select View>Versions to open the Versions window. 

 
How to View Volumes Required for Data Recovery 

 
You can view a list of the volume(s) needed to recover files and 
directories you have selected for recovery in the nwrecover 
program using the Volumes feature. The Volumes feature displays 
a windows providing the name of all volumes the NetWorker 
server needs to access in order to recovery the data you selected. 
 
To view a list of the volume(s) required for data recovery: 

 
1. Select the item whose volume information requirements you 

want to view. 
2. Select View>Volumes to open the Recover Volumes Required 

window. 
 

 
Disaster Recovery 

 
Note: You should keep a printed copy of these documents in a safe, 
convenient place away from the server. 
 

Directed recovery allows you, from an administering NetWorker client 
at a remote location, to direct a NetWorker server to perform both of 
the following: 

 
• Retrieve backed-up data from one of its NetWorker clients (a 
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source client) 
• Recover that data to a different NetWorker client (a destination 

client) within your enterprise. 
 

The destination client receiving the recovered data can be the source 
client itself or any other NetWorker client within the enterprise. 
Because you do not have to be physically present at either the source 
client, the destination client, or the NetWorker server itself, you have a 
high degree of flexibility and convenience in recovering and 
redirecting data. Directed recovery includes all  of the NetWorker 
server’s standard file handling features.   
 
You can use NetWorker for UNIX software to administer directed 
recoveries between UNIX, NT, and Windows 95/98 NetWorker clients 
by using the command line recover program. The nwrecover program 
does not support directed recovery tasks. 

 
Uses of Directed Recovery 

 
Directed recovery is very useful when data recovery is required for 
a shared server or other computer where users cannot recover the 
data themselves. If you have a NetWorker client installed and the 
appropriate access rights, the directed recovery feature allows you 
to perform the recovery from your own computer remotely rather 
than from the source computer itself. 
 
Directed recovery also permits the recovered data to be directed to 
other NetWorker client computers besides the requesting client 
computer. This allows you to share files and information with a 
broad range of NetWorker client computers. 

 
Access Requirements for Directed Recoveries of UNIX Clients 

 
Directed recovery is an administrator-level function and is 
typically not accessible for users and other nonadministrators. 
Performing directed recoveries requires you to have administration 
access for both the NetWorker server storing the data from the 
source client, and all destination clients receiving the recovered 
data. If you anticipate performing directed recoveries on a regular 
basis, you should establish the required permissions for each 
NetWorker server and client in your enterprise prior to receiving 
data recovery requests. 
 
Access requirements to perform directed recoveries of UNIX-
based 
NetWorker clients are as follows: 
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• All NetWorker clients and servers involved in the directed 

recovery must 
have the 6.x release of the software.  

• Your username must be included in the administrator’s list 
attribute of the NetWorker server that backs up the source 
client’s data, for example, username@administration_client. 

• The hostname of the NetWorker client with which you are 
administrating the directed recovery must be listed in the 
servers file of the following: 
o The NetWorker server computer 
o Each NetWorker client computer designated as being a 

potential destination client. 
• The user accounts on the NetWorker client administering the 

directed recovery must be included in the Remote Access 
attribute of each source Client resource of the NetWorker 
server. These are the accounts used on the NetWorker client 
that administrate the directed recovery, and the accounts 
owning the NetWorker client daemon (nsrexecd) on each 
destination client computer (root). For example, 

 user@administering_client_hostname and 
root@destination_client_hostname. 

 
The following sections describe how to set the various server and 

client administration rights required to enable directed 
recovery. 

 
How to Grant Administrative Rights for a NetWorker Server 

 
If you are using the NetWorker server to administer the directed 
recovery, your username needs to be listed as an administrator in 
that server. 
 
To grant administrative rights for a NetWorker server: 

 
1. Log in as root on the NetWorker server. 
2. Start the NetWorker Administrator program. 
3. Select Server>Server Setup to open the Server window. 
4.  Enter user@hostname in the Administrator attribute and click 

Apply. 
 
How to Grant Administrative Rights to a Remote NetWorker Server’s 
Client 

 
If you are administering directed recoveries remotely rather than 
from the NetWorker server, then your user account on the remote 

mailto:username@administration_client
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computer needs to be listed as an administrator in the NetWorker 
server. Your remote computer must also be included in the server’s 
file of that NetWorker server to allow your remote client computer 
to open a network connection to the NetWorker server. 
 
To grant administrative rights to a remote NetWorker server: 
1. Log in as root on the NetWorker server. 
2. Start the NetWorker Administrator program. 
3. Select Server>Server Setup to open the Server window. 
4.  Enter your user@administering_client_hostname in the 

Administrator attribute and click Apply. 
 

Next, you must add the administering NetWorker client computer 
name to the server’s file of that NetWorker server. 

 
1. Log in as root on the NetWorker server. 
2. Open the servers file, located in the /nsr/res directory, using 

your favorite text editor. 
3.  Enter the administering NetWorker client computer’s name in 

the servers file using the following format style: 
  mercury.legato.com 
4.  Save and close the servers file. 
5.  Enter the nsr_shutdown command at the shell prompt to shut 

down the NetWorker daemons.  A list of NetWorker daemons 
that will be shut down appears, along with a prompt that asks 
whether you want to continue with the nsr_shutdown 
command as follows: 

  
 # nsr_shutdown 
 
 nsr_shutdown will kill the following processes 
 25768 ? S 0:02 /usr/sbin/nsrexecd 
 25770 ? S 0:01 /usr/sbin/nsrexecd 
 25771 ? S 0:02 /usr/sbin/nsrd 
 25783 ? S 0:00 /usr/sbin/nsrmmdbd 
 25784 ? S 0:00 /usr/sbin/nsrindexd 
 25785 ? S 0:00 /usr/sbin/nsrmmd -n 1 
 Do you want to continue? [Yes]? Y 
6.  Start the NetWorker daemons by entering the appropriate 

command for your operating system: 
 – For Solaris, DYNIX/ptx, and IRIX: 
 # /etc/init.d/networker start 
 – For HP-UX: 
 # /sbin/init.d/networker start 
 – For AIX and Linux: 
 # nsrexecd 



 72

 # nsrd 
 – For Tru64 UNIX: 
 # /sbin/rc3.d/S94NSRstartstop start 

 
How to Grant a Network Connection to a Destination Client 

 
The administering NetWorker client computer must have access to 
the destination client in order to recover files onto it. You must add 
the administering NetWorker client computer name to the server’s 
file of that destination computer. 
 
To gain remote recovery permission to a destination client: 

 
1. Login as root on the destination client computer. 
2. Open the servers file, located in the /nsr/res directory, using 

your favorite text editor. 
3.  Enter the administering NetWorker client computer’s name in 

the servers file using the following format style: 
 mercury.legato.com 
4. Save and close the servers file. 
5.  Shut down the NetWorker daemons by entering the following 

command at the prompt: 
 # nsr_shutdown 
 A list of NetWorker daemons that are shutting down appears. 

You are also prompted as to whether you want to continue with 
the shutdown. Confirm the shutdown in each instance. 

6.  Start the NetWorker daemons. The commands required to start 
the NetWorker daemons depend on your operating system.  

 
How to Gain Remote Access to a NetWorker Client 

 
The administering client and the destination client must have 
remote administration access privileges for any source NetWorker 
client involved in a directed recovery. This access allows you to 
browse the source client file index and retrieve its files. You can 
add your hostname or user@hostname to the remote access list of 
any NetWorker client through the NetWorker Administrator 
program. Note that if you set the default client of a NetWorker 
server to include your hostname in its remote access attribute, all 
subsequently added clients will also list you as having remote 
access. 
 
To gain remote access to a NetWorker client: 
1. Log in to the NetWorker server, which includes the NetWorker 

client to which you want remote access. 
2. Start the NetWorker Administrator program. 
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3. Select Clients>Client Setup to open the Clients window. 
4. Select the client to which you want remote access in the Clients 

attribute. 
5. Enter the userid and user@administering_client_hostname of 

the administering client in the Remote Access attribute. 
6.  Enter the NetWorker client daemon account in the Remote 

Access attribute (root@destination_client_hostname) for every 
destination client you need or anticipate needing to access this 
source client resource. 

 
How to Perform a Directed Recovery Between UNIX Clients 

 
You perform directed recoveries between a UNIX source and a 
UNIX destination client using the recover command and various 
options at the command prompt. You cannot back up data from 
UNIX-based clients and recover them to Windows NT or other 
non-UNIX clients, or the reverse. The source and destination client 
must be of the same platform type.   
 
Also remember that a directed recovery is an interactive process 
only. Once you invoke the recovery, you still need to interactively 
select and recover files you choose from the source client index. 
 
recover Command in Directed Recoveries 
 
The recover command has a variety of options you can add to 
modify the basic browse and recover functionality. For performing 
directed recoveries, here are the following options: 

 
• -d The name of the directory where you wish to relocate the 

recovered files. 
• -s The name of the source client’s backup server.  
• -c The name of the source client. 
• -R The name of the destination client. 
• -i (Y,N,R) The recover option specifying what the NetWorker 

server should do if recovered files conflict with existing files of 
the same name.  Here is an explanation of each option (these 
are not case sensitive): 

– Y Overwrite the existing file when there is a naming 
conflict. 

  – N Skip restoring this file when there is a naming conflict. 
  – R Rename this file when there is a naming conflict. The 

NetWorker server automatically appends each conflicted 
filename with a “.R”. 

• [directory_name] The name of the initial directory in which to 
begin browsing. 
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For a complete listing of the recover command and all its options, 
see recover in the Legato Command Reference Guide. 

 
Example: Directed Recovery Overwriting Existing Files 

 
If the source client’s backup server was named venus, the 
source client itself was mars, the destination client was jupiter, 
and you wanted the recovered  files to overwrite any existing 
files with the same name, you would enter the following 
command at the prompt: 
 
# recover -s venus -c mars -R jupiter -iY [directory_name] 

 
Directed Recovery of Specific Files and Directories 

 
You must specify the items you want to mark for recovery using a 
set of procedures to mark files and directories for recovery. To 
perform a directed recovery of files and directories you specified: 

 
1. Enter the command to perform the directed recovery, using the 

following syntax style: 
 # recover -s server -c source_client -R destination_client - 

irecover_option [directory_name] 
2. Navigate to the directory containing file or directory you want 

to “mark” for directed recovery (if you did not specify the 
initial directory to browse by including a directory_name). For 
example: 

 # cd /var/adm 
3. Mark the item for directed recovery by entering the following 

command at the prompt: 
 # add file_name 
4. Repeat this procedure for each item you want to mark for 

directed recovery. 
5. View the items you have marked for recovery by entering the 

following command at the prompt: 
 # list 
6. Start the directed recovery by entering the following command 

at the prompt: 
 # recover 

  
How to Restore a Save Set Entry in the Online Indexes 

 
The following sections describe the process of restoring save set 
entries into one or both of the online indexes. 

 
Client File Index Only 
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If the file is not brows able (which means that the save set’s 
browse policy has expired), but its save set is still tracked by 
the NetWorker server in the media database (which means that 
the save set’s retention policy has not expired), follow these 
steps to recover the save set’s entry back into the client file 
index: 

 
1. Run the mminfo command by entering the following 

command: 
# mminfo -a -v volume_name 

2. From the mminfo output, find the ssid that you believe 
contains the file you want. Make sure it is not the bootstrap 
ssid. 

3. Restore the save set entry in the client file index using the 
nsrmm program by entering the following command: 
# nsrmm -s ssid -t retention_time 

 
Client File Index and Media Database 

 
If the save set that contains the file is not browsable and the 
save set is not represented in the media database, both the 
browse and retention policies have expired. 
 
To rebuild the save set’s entry in both the client file index and 
the media database: 

 
1. Run the scanner program on the backup volume that you 

believe contains the file you want by entering the following 
command: 
# scanner device_name 

2. Use the output from the scanner program to decide 
whether to reintroduce the contents of this volume into the 
client file indexes and whether the save set you want to 
rebuild is on this volume. (You must locate all the volumes 
that contain this save set ID.) 

3. After you have determined which volumes to reintroduce 
into the online indexes, run the scanner command: 

 # scanner -i device-name 
 The scanner command prompts for a new volume until you 

terminate it.  To rebuild the indexes completely, you must 
scan in all the volumes that contain the ssid. 

4. Use the nwrecover program to browse the file index for the 
file you want to recover. 

 
 

How to Recover One File Directly from a Volume 
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To recover a single file from a volume, run one of the 
following commands: 
 
# scanner -S save_set_id device_name | uasm -rv filename 
 
or 
 
# scanner -S save_set_id device_name | uasm -rv -m 
source=dest 
filename 
 
The –m option of uasm maps (relocates) the recovered file 
from the source to 
the dest (destination) directory. 

 
Recovering Client File Indexes 

 
The following sections explain different procedures for 
recovering the online index. 

 
How to Recover a Client’s Current File Index 
 

Unlike regular backed-up data, recoveries of client file 
index information are performed using the nsrck program 
with the -L7 option. If you do not specify any time or date 
information, the current client file index is recovered. 

 
To recover the online index of a client, enter the following 
command: 

 
# nsrck -L7 client_name 

 
How to Recover Client File Indexes for a Specific Time and 
Date 

 
With the NetWorker release 6.0 and later software, it is 
possible to recover a client file index for a certain time and 
date, using the -t “time date” option with nsrck. The time 
and date formats are in nsr_getdate format.  

 
Client file index recovery using the NetWorker product is 
non-destructive, so when you recover the client file index 
as of a time and date in the past, nsrck will add the entire 
contents of the index as of that time and date, to the current   
contents of the index. Generally, this means your client file 
index will become much larger.  
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The benefit of recovering the client file index as of a 
specific time and date is that you can browse save sets that 
had passed their browse policy but were still recoverable. 
The save sets referred to by the recovered client file index 
will be marked as browsable. They will remain browsable 
for the length of time they were originally browsable. 
 
To recover a client index for a specific date, enter the 
following command: 
 

# nsrck -t "time mm/dd/yyyy" -L7 client_name 
________________________________________________ 
Example: Recovering a Client File Index for a Specific 
Time and Date 
 
In this example, you are recovering a client file index to 4 
PM, March 2 1999: 
 

# nsrck -t "04 pm 03/02/1999" -L7 client_name 
________________________________________________ 

 
Relocating Recovered Online Indexes 

 
You can relocate recovered online indexes depending on the 
release of 
NetWorker software that performed the backups. 

 
NetWorker Release 6.0 Software 

 
You can recover online indexes to a different directory only if 
all the backups 
were made using the NetWorker release 6.0 software. 

 
 
 

Type II – Server and Client Failure 
  

How to Recover the UNIX Operating System 
This section describes how to recover the UNIX operating system.  
Use this process to recover the operating system back to the 
original computer or to a different computer. 
 
You can recover the operating system by performing either a: 
• Complete installation.  In this instance you perform a complete 

installation and configuration of the operating system. 
Or 
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• Partial installation.  In this instance you install and configure 
only those files that enable the computer to communicate over 
the network.  Then, recover the remaining operating system 
and configuration files using NetWorker. 

 
_________________________________________________________ 
Important:  Do not recover the operating system from an X session.  
Rather, recover the operating system in singe-user mode from the 
system console. 

 
To recover the operating system, follow these procedures, 

explained in detail in the following sections: 
1. Install the operating system. 
2. Configure the operating system. 
3. Test the operating system and configure the devices. 

 
Task 1: Install the Operating System 

 
To install the operating system: 
1. Install the same version and patch level of the UNIX 

operating system into its original location. 
If you want to upgrade the operating system, first recover 
the operating system as it was previous to the disaster, and 
then perform the upgrade. 

2. Recreate all of the filesystems that were previously on the 
computer. 
The filesystems must be: 
• The same filesystem type. 
• At least the same size as before to hold all of the 

backed-up data. 
 At a minimum, configure the root volume group and 
kernel parameters, such as asynchronous I/O.  If the 
resources are available, reconstruct non-root volume group 
filesystems and logical volumes. 

 
Task 2: Configure the Operating System 

To configure the operating system: 
1. Configure the network exactly as it was configured before 

the disaster.  If you do not, NetWorker will treat the 
computer as a new computer.  If the computer has a 
different host ID you must reregister the NetWorker 
software.   

2. If you are recovering the operating system to a different 
computer, assign the same hostname for the new computer.  
If you do not use the same hostname, you will not be able 
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to recover the NetWorker indexes associated with the 
original computer. 

3. Configure the date and time as they were configured 
before, including he time zone. 

4. Install any additional UNIX components or services before 
recovering the computer’s data. 

5. Reboot the computer. 
 

Task 3: Test the Operating System and Configure the Devices 
To test the operating system and configure the devices: 
1. Configure any devices required by NetWorker, for example 

SCSI pass-through devices for authochangers. 
2. Perform a test to verify that the: 

• Name to Address resolution ad TCP/IP are functioning 
properly.  This is performed by running ping to 
communicate with a client or storage node, and then 
running ping on the client to reach the server. 

• Operating system is functioning properly. 
• Tape drive is functioning properly.  This test can be 

performed using mt commands. 
• Devices are recognized by the operating system.  If the 

devices are not recognized by the operating system, you 
might need to: 
1. Load the SCSI driver. 
2. Install the device driver. 
3. Modify the device configuration files to enable the 

computer to communicate with the device during 
recovery.   

 
How to Recover a UNIX NetWorker Server 

 
To recover a NetWorker server, follow these procedures, explained 
in detail in the following sections: 
1. Install NetWorker. 
2. Configure NetWorker. 
3. Locate the server’s bootstrap save set ID. 
4. Recover the NetWorker server bootstrap. 
5. Rename the NetWorker server configuration files. 
6. Recover all indexes for clients on the NetWorker server. 
7. Recover the NetWorker server’s client data. 
8. Complete the server recovery. 

 
Task 1: Install NetWorker 

To install NetWorker: 
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1.  Install the same version of NetWorker into its original 
location. 

• If you are using UNIX and you have a NetWorker server 
that is similar in configuration to the one being recovered, 
you can access the NetWorker binaries via NFS. 
For example: 

 mount venus:/usr/sbin /mnt 
 /mnt/nsrexecd –s server-name 
 /mnt/recover –s server –q 
 recover> add / 
 recover> force 
 recover> recover 

• If you want to upgrade the NetWorker server, first 
recover the server to its original state, then perform the 
upgrade. 

• You do not need to reload the license enablers if the 
NetWorker configuration files still exist. 

 
Note: Reuse these NetWorker configuration files only if the 
NetWorker server’s hard drive did not crash and you are 
updating or reinstalling NetWorker. 

2.  Install any NetWorker patches that were installed prior to 
the disaster. 

3.   If you are using UNIX, recreate any links that you had to 
the NetWorker directories (such as the NetWorker indexes 
and configuration files). 

 
Task 2: Configure NetWorker 

 
To configure NetWorker: 
1. If you want to use an autochanger for the remainder of the 

recovery process, ensure that the autochanger resource 
exists.  By default, this is located in the /nsr/res directory. 

2.  Configure the Device resource(s). 
 If you want to recover your data using an autochanger, add 

and configure the autochanger using the jbconfig 
command.  

 
 If you are using an autochanger, reset the autochanger 

using the nsrjb –vHE command.  This command resets the 
autochanger, ejects backup volumes, reinitializes the 
element status, and checks each slot for a volume. 

 
 If you autochanger does not support the –E option, 

initialize the element status using sjiielm. 
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 If you are using an autochanger, inventory the autochanger 
using the nsrjb –I command.  This will help you determine 
whether the volumes required to recover the bootstrap are 
located inside the autochanger. 

3.  Note: If you are recovering a relocated server’s file index 
from a NetWorker 6.0 or later version backup, then this 
step is no longer necessary. 
a.   If you are recovering the server’s file index from a 

NetWorker pre-6.x version backup and you relocated 
the server’s file index path to a new location: 

 
b. Edit the Index Path attribute in the server’s attribute in 

the server’s associated Client resource. 
c. Shut down and restart the NetWorker services 

(Windows NT) or daemons (UNIX).    
 

Task 3: Locate the Server’s Bootstrap Save Set ID 
 

This section describes how to locate the save set ID for the 
NetWorker server’s latest bootstrap.  The bootstrap contains 
the media database and resource configuration files. 

 
To locate the save set ID of the most recent bootstrap (if you 
do not already have this information): 
1. Insert the most recent media or clone volume(s) used for 

scheduled backups into the appropriate device. 
2. At the system console/command prompt, switch to the 

directory where the NetWorker binaries and executables 
are located. 

3. If you are using an autochanger, insert the first volume of 
the bootstrap save set into the first drive of the autochanger 
using the following command:  
 
nsrjb –lnv –S slot –f device-name 
 
where slot is the slot where the first volume is located and 
device-name is the pathname for the first drive.  You can 
obtain this device-name using the inquire command. 

4. Use the scanner –B command to determine the save set ID 
of the most recent bootstrap on the media. For example: 
UNIX: 

 
scanner –B \\.\Tape0 

 
If you do not locate the save set ID of the most recent 
bootstrap on the most recent media, run the scanner –B 
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command on preceding media to locate the save set ID of 
the most recent bootstrap. 

5. When you see the output, record both the bootstrap save set 
ID and the volume label. 

 
Task 4: Recover the NetWorker Server Bootstrap 

 
This section describes how to recover the NetWorker server 
bootstrap using the mmrecov command. 
 
Note: In NetWorker 6.0, the mmrecov command is only used 
to recover the NetWorker server’s media database and resource 
configuration files, the nsrck command is used to recover the 
server’s client indexes. 
To recover the NetWorker server bootstrap: 
1. Use the volume label from the previous task to determine 

which pool it belongs to.  If the bootstrap was backed up to 
a pool that is not specified in the Pool resource, create the 
pool. 

2. Use the mmrecov command to recover the NetWorker 
server’s bootstrap.  For example: 

 
 UNIX:  
 mmrecov 
 The following output appears: 
 mmrecov: Using Madrid.spain.com as server  
3. If the following message appears, enter the name of the 

device you are using for the recovery (this message only 
appear if the server has multiple devices configured and 
enabled). 

 
 UNIX: 
 What is the name of the device you plan on using  
 [/dev/rmt/0hbn]? /dev/rmt/0hbn 
4. When the following message appears, enter the save set ID 

for the latest bootstrap.  If you are recovering a cloned 
version of bootstrap, specify the save set ID associated with 
the clone. 

5. When the following message appears, enter the file number 
to begin the recover.  If unknown, press [Enter]. 

 Enter starting file number (if known) [0]: 130 
 
6. When the following message appears, enter the first record 

number to begin the recovery.  If unknown, press [Enter]. 
 
 Enter starting record number (if unknown) [0]: 0 
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7. When the following message appears, follow the prompt: 
 
 UNIX: 
 
 Please insert the volume on which save set id 20076 started 

into /dev/rmt/0hbn. 
 
 Once you have loaded the appropriate volume, the 

following message appears: 
 
 Scanning /dev/rmt/0hbn for save set 20076; this might take 

a while… 
 
 NetWorker then scans the volume for the appropriate save 

set and recovers it. 
 
 Note: you can use the nwadmin program to monitor the 

recovery of the media database and resource configuration 
files. 

 
 The NetWorker media database and resource configuration 

files are recovered when the following message appears: 
 
 If your resource files were lost, they are now recovered in 

the ‘res.R’ directory. 
 
 Copy or move them to the ‘res’ directory, after you have 

shut down the service.  Then restart the service.  Otherwise, 
just restart the service. 

 
 If the on-line index for the server-name was lost, it can be 

recovered using the nsrck command. 
 

Task 5: Rename the NetWorker Server Configuration Files 
 

Because the configuration files cannot be reliably overwritten 
while NetWorker is running, mmrecov recovered the res 
directory as res.R by default.  In addition, mmrecov might 
have recovered another server’s configuration and NetWorker 
Backup and Recover Server  services/daemons is 
recommended. 
 
To rename the configuration files in UNIX: 
1.  Shut down (stop) the daemons by entering the 

nsr_shutdown command at the UNIX command prompt: 
 nsr_shutdown 
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2. Rename the existing /nsr/res directory to /nsr/res.orig: 
 mv res res.orig 
3. Rename the recovered /nsr/res.R directory to /nsr/res: 
 mv res.R res 
4. Restart NetWorker by first entering the nsrexecd command; 

then enter the nsrd command to complete the NetWorker 
restart: 

 Nsrexecd 
 Nsrd 
 Note: You can also restart NetWorker by running the 

NetWorker startup script for the appropriate platform. 
5. After verifying that the NetWorker configurations are 

correct, remove the /nsr/res.orig directory. 
 

Task 6: Recover All Indexes for Clients on the NetWorker Server 
 

Once you recover the server’s media database and resource 
configuration files, recover all indexes for clients on the 
NetWorker server. 
 
To recover all indexes for clients on the NetWorker server: 
1.  Enter the nsrck -L7 command: 
   nsrck -L7 client-name 
   Note: If you do not supply a client name, the indexes of all 

clients will be 
      recovered. 
2.  If you are using a cloned version of the index, NetWorker 

may prompt you 
   to load an original volume (not the clone volume). 
  To use the clone: 

a. Enter a [Ctrl]+[c] to exit out of nsrck and verify that the 
pending original volume message has terminated. 

b. Delete the records of the original volume(s) using the 
nsrmm -d volume-name command. For example: 
NetWorker requests the original volume mars.1. 
Because this volume is not available, delete the mars.1 
volume from the media database using the following 
command: 
nsrmm -d mars.1 

c.  Restart the NetWorker server services (Windows NT) 
or daemons 
(UNIX). 

d.  Enter the nsrck -L7 command: 
nsrck -L7 client-name 

 
Task 7: Recover the NetWorker Server’s Client Data 
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This procedure describes how to recover the remainder of the 
NetWorker 
server’s data, including the registry, using the NetWorker User 
program 
(Windows NT) or the nwrecover program (UNIX). 
 
To recover the NetWorker server data: 
1.  Log on as Administrator (Windows NT) or as root (UNIX). 
2.  Load and inventory the devices. This ensures that 

NetWorker can 
  recognize the location of each volume. 
 

If you load a clone volume, NetWorker uses the clone 
volume for the remainder of the recovery process. 

3.  Run the NetWorker User program (Windows NT) or the 
nwrecover 

     program (UNIX). 
4. Select and mark the directories for recovery. 
5. Click Start to begin the recovery. 

 
______________________________________________________ 
Important: Once the media database and server resource 
configuration files have been recovered, you may recover the client 
indexes in any order. It is not necessary to recover the server’s own 
client index before recovering the index of any other client.  
 
If your  clients have the NetWorker client installed, you may run 
on-demand and scheduled saves once the media database and 
server resource configuration files are recovered; however, you 
will not be able to browse the saves for a client until you recover 
the client’s file index. You may use save set recover to recover 
files before client’s file index is recovered. 

 
 

Task 8: Complete the Server Recovery 
 
To complete the server recovery process: 

1.  Perform a test backup or recover to make sure the server is 
fully recovered. 

2.  Verify that the server and its associated clients are included 
in a scheduled 

  backup. 
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6. Application/Data Recovery – Server/Client 
  
 Installing Client Software – Linux 
 

The installation script removes existing NetWorker client software and man pages 
when you install this release of NetWorker software.   

  
General Instructions 
You can install the NetWorker client software for Linux separately on the 
NetWorker Server for Linux.  You can also install the NetWorker client software 
for Linux on a different computer as a client only; this requires a separate 
ClientPak enabler code. 
 
Installing the man pages is also offered as a separate option. 
 
How to install the client software 

1. Save the original files described above if you want to keep a copy of your 
current configuration. 

2. Access the Legato NetWorker installation software from the distribution 
media. 

3. Enter the Nwinstall command at the command prompt: # ./Nwinstall 
4. At the prompt, enter the corresponding number fro the opting to install the 

lgtoclnt package.  Installing this package temporarily requires 70 MB of 
free space on the client computer. 

5. (Optional) At the prompt, enter the appropriate number for the option to 
install the man pages (lgtoman). 

6. When you have added all the applicable packages and the prompt is 
displayed, exit the installation script. 

7. If you did not specify a set of NetWorker servers during the NetWorker 
client installation but you want to limit the server authorized to access the 
client, you can specify a list of trusted NetWorker servers for your client 
using the /nsr/res/servers file. 
 
Use the following procedure to change the set of NetWorker servers that 
are authorized to access this client. 

a. Shut down the NetWorker daemons.  For example: # 
nsr_shutdown 

b. Edit or create the /nsr/res/servers file and add the set of 
NetWorker servers, one per line, that you want to grant access 
to this client.  The first entry in this file becomes the default 
NetWorker server. 

c. Check the NetWorker boot-time startup file for nsrexed –s 
arguments.  If they exist, delete the –s arguments.  The 
nsrexecd –s argument supercedes the /nsr/res/servers file. 
For example, delete the arguments for nsrexecd in the file 
shown below: 
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#vi /etc/rc.d/init.d/networker 
nsrexecd –s venus –s mars 
The nsrexecd daemon named in the file 
/etc/rc.d/init.d/networker should appear only as: nsrexecd 

d.   Use the NetWorker boot-time startup file to restart the 
NetWorker software. 
# /etc/rc.d/init.d/networker start 

 
 

Disaster 
 
Type I – Client Failure Only 
 
Recovering Client or Storage Node Data 
 

To recover client or storage node data: 
• Meet the client or storage node data recovery prerequisites. 
• Recover the client or storage node data. 

 
Prerequisites 

 
To recover the client or storage node data, you need the 
following: 
• Version and patch level of NetWorker. 
• Location of NetWorker. 
• NetWorker ClientPak for your operating system. 
• Backup or clone volumes containing the NetWorker client 

data you wish to recover. 
 

How to Recover Windows NT 4.0/UNIX Client or Storage Node Data 
 

This section describes how to recover client or storage node data. 
You can use 
this process to recover the client or storage node data either back to 
the original 
computer or to a different computer. 

              _____________________________________________________ 
Important: If the NetWorker server has failed, it should be fully 
recovered and functional before attempting to recover client or 
storage node data. 
______________________________________________________ 

 
To recover client or storage node data, follow these procedures, 
explained in 
detail in the following sections: 
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1. Install NetWorker, if necessary. 
2. Recover the client or storage node data. 
3. Complete the client or storage node data recovery. 

Task 1: Install NetWorker 
 

This section describes how to install NetWorker on a client or 
storage node.  Before starting this procedure: 
 
• Determine what Legato backup utility software was 

installed on the computer prior to the disaster (for example, 
SmartMedia, ClientPak, NetWorker Module). 

• Determine what Legato backup utility patches were 
installed prior to the disaster. 

• Determine whether the Legato backup utility software or 
patches are actually damaged to the point where they need 
to be reinstalled. 

 
If the client’s or storage node’s NetWorker software is not 
properly installed 
and running: 
 
1.  Install the same version of NetWorker, which had been 

installed on the computer prior to the disaster, into its 
original location.  If you want to upgrade the client or 
storage node software, first recover the client or storage 
node to its original state, and then perform the upgrade. 

2.  Install any NetWorker backup utility patches that were 
installed prior to the disaster. 

3.  From the NetWorker User program (Windows NT) or the 
nwrecover program (UNIX), perform a test recovery to 
ensure that the NetWorker recovery process is functioning 
properly. 

 
Task 2: Recover the Client or Storage Node Data 

 
This section describes how to recover the client or storage node 
data, including the registry or system state. 
___________________________________________________ 
Important: (Windows NT) If you receive a message 
instructing you to reboot the computer, you must reboot prior 
to recovering the registry (5.5.1 clients) or system state (5.7/6.0 
clients). 
___________________________________________________ 

 
To recover the client or storage node data: 
1.  To determine the volumes required to recover the client or 
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storage node data, use the mminfo -avot command on the 
server. 

2.  Start the NetWorker User program (Windows NT) or the 
nwrecover program (UNIX). 

3.  Mark all the drives or filesystems and any operating system 
specific special backups, such as the registry (5.5.1 clients) 
or System State (5.7/6.0clients). 

4.  If you are recovering a NetWorker server, unmark the 
following NetWorker directories and files before 
recovering the remainder of the server data: 
• NetWorker server’s client indexes, by default located in 

the  /nsr/index/server-name directory. 
• NetWorker media database, by default located in the 

/nsr/mm directory. 
• NetWorker resource configuration files, by default 

located in the /nsr/res directory. 
• Any boot files required for UNIX operating system 

recovery that you determined should not be overwritten. 
5.  For Windows NT only, recover the RepairDisk, if required. 

 
___________________________________________________ 
Important: In version 5.5.1, NetWorker does not back up 
profiles as part of the %SystemRoot%\profiles directory; rather, 
it saves this data with the REGISTRY: saveset. Therefore, the 
registry must be recovered in its entirety to recover a user 
profile. In versions 5.7 and 6.0, the profiles are backed up and 
recovered as part of the SYSTEM STATE: save set. 
 
The SYSTEM STATE can be recovered only to the same 
server it was created on, or, to another computer with exactly 
the same architecture. 
___________________________________________________ 

 
6.  Set the recover options by selecting the Overwrite Existing 

File from the Options>Recover Options menu. 
___________________________________________________ 
Important: If you did not set the recover options, you must 
select the 
Overwrite Existing File option when the Naming Conflict 
dialog box appears 
during the recovery process. To enable automatic overwriting 
of files with the 
same name, select the Suppress Further Prompting option in 
the Naming Conflict dialog box. 
___________________________________________________ 
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7.  Select Start. 
For Windows NT, files in the Recycle Bin are not 
password-protected.  When the Password Protection 
window appears, select Recover>OK to recover these files. 
NetWorker logs the output of the recovery process to the 
NetWorker logs directory (networkr.log), which is 
overwritten each time a recovery is performed. 

8.  Reboot the computer. The computer should now be 
restored to the state prior to the disaster. 

 
Task 3: Complete the Client or Storage Node Data Recovery 

 
To complete the client or storage node data recovery process: 
1.  Perform a test recovery using each of the Legato backup 

utilities incorporated into your backup solution. 
2.  Recover your data using the Legato backup utility you used 

to back up the data. Refer to the appropriate 
Administrator’s Guide for details. 

 
For Windows NT only, once you have completed the recovery 
process: 
• If you want to use Active Desktop, install it after you have 

recovered all of the computer’s data. 
• If the computer is a Backup Domain Controller (BDC), 

synchronize it with the Primary Domain Controller (PDC). 
• If the computer is a Primary Domain Controller (PDC), 

synchronize it with the domain. 
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7. Updating/Testing of Plan and Analysis 
• Once every semester the procedure to shutdown all machines (2.1) should 

be tested.   
• This document should be updated twice a semester.  From my experience, 

Scott receives new products (software, hardware) approximately every 
two weeks.  It would be quite tedious to update this document every two 
weeks so I recommend purchasing or designing an asset management 
software, which would be an easier way of monitoring SILS’s products. 

 
Test Dates 

Date Comments 
September 15th  
November 15th  
February 15th  
April 15th  

 
 Analysis of SILS IT Infrastructure 

From all my reading and interviews with professional IT managers I have come to 
the conclusion that prevention should be the most important aspect when 
considering disasters and how these disasters could affect your IT infrastructure, 
instead of focusing mainly on recovery.  An IT Recovery plan should customize 
and evaluate your recovery strategies according to application importance, 
processing-time sensitivity and system type.  Hypothetically, if money was not an 
issue, a multifaceted and functional plan should consist of: 

• A separate location to accommodate critical personnel and equipment 
• Data storage or application and web servers duplicated in another 

geographic location 
• A documented, up-to-date and tested disaster plan 
• A crisis IT team 
• An updated recovery and business-resumption plan  

However, having limited resources and not being able to have an offsite with 
duplicate servers, there are other improvements that my reduce the effects of a 
disaster: 

• ATN/System Enterprise Recovery Group provides a network backup 
service at a cost of $10/gigabit.  SILS could use this service to run a 
network backup on specific partitions, directories, or files from Onyx.  
This service could be used in conjunction with our tape backup system or, 
after doing a feasibility test, it could replace our backup procedure. 

• Create or purchase an asset management tool that will take stock of all 
equipment, hardware and software making it easier to update this IT 
Recovery plan.  Having an up-to-date plan is very important.  

• Forming an alliance with another department on campus such as the 
Computer Science CS department and having an agreement to provide a 
secure space for each other to use is an inexpensive way of attaining an 
offsite.  SILS will be able to store their most recent backed-up tapes, 
documentation, licenses, and copies of software for free.  
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8. Supplies 
  
   

Element Quantity 
Monitors 23 
Pairs of Speakers 33 
100 MB Zip Drives 1 box 
Transfer Switches (old) 1 box 
Mice 2 boxes 
RJ45 (Network Cable) 1 box 
IDE ribbon 1 box 
Keyboards 43 
Print Cartridges 1 box of 5M and 1 box of 6M 
PCs 21 
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Appendix A 
 
Computer Serial No. Computer Name Location Computer Model Machine Type IP Address EOSC Tag 
S/N 78-ONG8D ADAMS OFFICE115 THINKPAD T30 IBM 152.2.81.250 C16224 

 

C2BWF11      

  

        

      

       

       

       

       

       

      

       

      

       

       

AWAITING_NAME OFFICE115A POWEREDGE2550 DELL none yet M66791
 

NEED_DATA BACKUP JUKEBOX CLOSET114D STOREDGE L1000 SUN NA M61626 
 

S/N 78-XML82 BARREAU MOBILE THINKPAD T30 IBM 152.2.81.203 C20380 
 

GUD27 BARRYM OFFICE115 OPTIPLEX GX110 DELL 152.2.81.174 M61142 

615FO145 BERYL OFFICE306 ULTRA 1 SUN 152.2.81.13 NA
 

GUG14 BMH OFFICE OPTIPLEX GX110 DELL 152.2.81.220 M61132
 

GUGHP CARR OFFICE202 OPTIPLEX GX110 DELL 152.2.81.234 M61129
 

C6MH5 CDROM1 LIBRARY OPTIPLEX GXA DELL 152.2.81.181 M49634
 

C6MKB CDROM2 LIBRARY OPTIPLEX GXA DELL 152.2.81.182 M49630
 

C6MNG CDROM3 LIBRARY OPTIPLEX GXA DELL 152.2.81.183 M49649
 

C6MJ7 CDROM4 LIBRARY OPTIPLEX GXA DELL 152.2.81.184 M49627
 

2Q1A CDWRITER MOBILE UII-RW32E BUSLINK NA NA
 

GUG15 DANIEL OFFICE216 OPTIPLEX GX110 DELL 152.2.81.204 M61114
 

ENTER7 DEAN-LAPTOP MOBILE THINKPAD IBM 152.2.81.48 NULL
 

18789 DIGITALCAMCORDER MOBILE 120X SONY NA NA
 

343659 DIGITALCAMERA MOBILE MVC-CD300 SONY NA NA
 

JV1BZ11 FALCON SERVER ROOM POWEREDGE 2650 DELL 152.2.81.18 M68026 
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284078       

       

       

      

    

       

    

      

      

      

   

FD7DIGITALCAMERA MOBILE 10XMAVICA SONY NA NA
 

173663 FD83DIGITALCAMERA MOBILE 4XMAVICA SONY NA NA
 

1022642 DUCK NETWORK LAB SERVER NETWORK APP NA NA 
 

175V10B GHOST SERVER OFFICE115 XPST700R DELL 152.2.81.100 NA
 

BUP GHOSTSERVER OFFICE115 XPST700R DELL 152.2.81.100 NA
 

GUGHZ GOLLOP OFFICE204 OPTIPLEX GX110 DELL 152.2.81.218 M61134
 

GUGHD GRAHAM OFFICE116 OPTIPLEX GX110 DELL 152.2.81.216 M61115
 

GUGHW GREENBERG OFFICE207A OPTIPLEX GX110 DELL 152.2.81.228 M61121
 

66SHD11 GUINEA SERVER ROOM POWEREDGE 2550 DELL 152.2.81.16 M66609 

S/N 78-XML65 HAAS MOBILE THINKPAD T30 IBM 152.2.81.202 C20497 
 

IQ4A HARDDRIVE MOBILE USB2.0 HARD DRIVE BUSLINK NA NA
 

S/N 78-XML33 ILS.JACKSON ADMIN OFFICE THINKPAD T30 IBM 152.2.81.243 C20325 
 

NEEDDATA300 JADE SERVER NETWORK LAB SUN FIRE 280R SUN 152.2.81.4 M64818 
 

NeedingData9 JANEG-PC1 OFFICE007 NULL NULL 152.2.81.68 NULL
 

NeedingData10 JANEG-PC2 OFFICE007 NULL NULL 152.2.81.69 NULL
 

G41ZX01 KIWI SERVER CLOSET114D POWEREDGE 4400 DELL 152.2.81.10 M61525 
 

2645-UN1 S/N 78-YCF70 LAPTOP1 MOBILE THINKPAD 600E IBM 152.2.81.70 C05503 
 

2645-UN1 S/N 78-YCF76 LAPTOP2 MOBILE THINKPAD 600E IBM 152.2.81.72 C06097 
 

2626-UN1 S/N AF-173K7 LAPTOP3 MOBILE THINKPAD 390E IBM 152.2.81.73 C06135 
 

2647-UN5 S/N 78-3RX1P LAPTOP4 MOBILE THINKPAD T22 IBM 152.2.81.74 C16214 
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2647-UN5 S/N 78-3TH1H LAPTOP5 MOBILE THINKPAD T22 IBM 152.2.81.75 C16988 
 

2647-UN5 S/N 78-3THOY LAPTOP6 MOBILE THINKPAD T22 IBM 152.2.81.76 C16991 
 

2647-UN5 S/N 78-3TH1K LAPTOP7 MOBILE THINKPAD T22 IBM 152.2.81.77 C16990 
 

2647-UN5 S/N 78-3TH2F LAPTOP8 MOBILE THINKPAD T22 IBM 152.2.81.78 C16992 
 

2647-UN5 S/N 78-3THOW LAPTOP9 MOBILE THINKPAD T22 IBM 152.2.81.79 C16989 
 

FQKMR   

      

     

    

     

   

     

     

       

        

        

LIBRARY1 LIBRARY OPTIPLEX GX1 DELL 152.2.81.214 NA 
 

7501l LIBRARY2 OFFICE116 DIMXPSPRO200n DELL 152.2.81.215 M40494
 

FQKNV LIBRARY3 OFFICE116 OPTIPLEXGX1 DELL 152.2.81.219 NULL
 

GUGHM LOSEE OFFICE302 OPTIPLEX GX110 DELL 152.2.81.200 M61124
 

GUGHE MACDONALD ADMIN OFFICE OPTIPLEX GX110 DELL 152.2.81.236 M61126
 

NEED_DATA3 MAIL SERVER CLOSET114D POWEREDGE 2300 DELL 152.2.81.17 M54199 
 

AWAITING DATA MARCHIONINI OFFICE203 THINKPAD T30 IBM 152.2.81.235  
 

NOSN1 MICROCASSETTERECORDER1 MOBILE S724 OLYMPUS NA NA
 

NOSN2 MICROCASSETTERECORDER2 MOBILE S724 OLYMPUS NA NA
 

GUGHV MORAN OFFICE211 OPTIPLEX GX110 DELL 152.2.81.245 M61133
 

S/N 78-XMM71 NEWBY MOBILE THINKPAD T30 IBM 152.2.81.221 C20987 
 

15014072 NONE NETWORK LAB TAPE LIBRARY SUN NA NA 
 

0181H2015 NONE NETWORK LAB DISK ARRAY SUN NA NA
 

0181H2016 NONE NETWORK LAB DISK ARRAY SUN NA NA
 

122C047D NONE NETWORK LAB SERVER 280R SUN NA NA 
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122C047F NONE NETWORK LAB SERVER 280R SUN NA NA 
 

12KX02842       

      

    

      

     

       

      

      

     

     

     

     

    

     

       

     

     

NONE OFFICE116 COPIER KONICA NA NA
 

2G04094 NONE S2 STORAGE RS/6000 SUN NA NA
 

7069 NONE NETWORK LAB  DISK SUBSYSTEM MICROWAY NA NA
 

9CJJG NONE S2 STORAGE POWEREDGE 4100 DELL NA NA 
 

ABUG20400066 NONE CLASSROOM117 PROJECTOR PROXIMA NA NA
 

G8Y01662 NONE S2 STORAGE PROJECTOR PROXIMA NA NA
 

NQG07678 NONE OFFICE106 COPIER CANNON NA NA
 

QB0036313888 NONE OFFICE306 COMPUTER MICROWAY NA NA
 

UNK1 NONE OFFICE300A X5516A SUN NA NA
 

UNK2 NONE CLASSROOM214 PROJECTOR PROXIMA NA NA
 

UNK3 NONE CLASSROOM215 PROJECTOR PROXIMA NA NA
 

UNK4 NONE CLASSROOM208 PROJECTOR PROXIMA NA NA
 

UNK5 NONE CLASSROOM304 PROJECTOR PROXIMA NA NA
 

UNK6 NONE OFFICE115A PORTABLE PROJECTOR PROXIMA NA NA
 

804K9 NTSERV CLOSET114D POWEREDGE 4100/200 DELL 152.2.81.15 M40915
 

017H35E5 ONYX SERVER CLOSET114D ENTERPRISE250 SUN 152.2.81.3 M61627
 

610F1258 OPAL OFFICE206 ULTRA 1 MODEL 170E SUN 152.2.81.11 NA 
 

2Q34B01 PC1 LAB CLASSRM DIM8100 DELL 152.2.81.101 M65501
 

G744B01 PC10 LAB CLASSRM DIM8100 DELL 152.2.81.110 M65502
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2T34B01     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

PC11 LAB CLASSRM DIM8100 DELL 152.2.81.111 M65503
 

6244B01 PC12 LAB CLASSRM DIM8100 DELL 152.2.81.112 M65504
 

2744B01 PC13 LAB CLASSRM DIM8100 DELL 152.2.81.113 M65505
 

HP34B01 PC14 LAB CLASSRM DIM8100 DELL 152.2.81.114 M65506
 

9244B01 PC15 LAB CLASSRM DIM8100 DELL 152.2.81.115 M65507
 

2644B01 PC16 LAB CLASSRM DIM8100 DELL 152.2.81.116 M65508
 

4Q34B01 PC17 LAB CLASSRM DIM8100 DELL 152.2.81.117 M65509
 

D644B01 PC18 LAB CLASSRM DIM8100 DELL 152.2.81.118 M65510
 

4644B01 PC19 LAB CLASSRM DIM8100 DELL 152.2.81.119 M65511
 

9744B01 PC2 LAB CLASSRM DIM8100 DELL 152.2.81.102 M65512
 

6744B01 PC20 LAB CLASSRM DIM8100 DELL 152.2.81.120 M65515
 

7544B01 PC21 LAB CLASSRM DIM8100 DELL 152.2.81.121 M65516
 

8844B01 PC22 LAB CLASSRM DIM8100 DELL 152.2.81.122 M65517
 

3Q34B01 PC23 LAB CLASSRM DIM8100 DELL 152.2.81.123 M65503
 

1844B01 PC24 LAB CLASSRM DIM8100 DELL 152.2.81.124 M65519
 

2944B01 PC25 LAB CLASSRM DIM8100 DELL 152.2.81.125 M65520
 

C544B01 PC26 LAB CLASSRM DIM8100 DELL 152.2.81.126 M65521
 

9644B01 PC27 LAB CLASSRM DIM8100 DELL 152.2.81.127 M65522
 

D244B01 PC28 LAB CLASSRM DIM8100 DELL 152.2.81.128 M65523
 

F744B01 PC29 LAB CLASSRM DIM8100 DELL 152.2.81.129 M65524
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1Q34B01     

     

     

     

      

      

      

      

      

      

      

      

      

     

     

     

     

     

PC3 LAB CLASSRM DIM8100 DELL 152.2.81.103 M65525
 

HS34B01 PC30 LAB CLASSRM DIM8100 DELL 152.2.81.130 M65526
 

G544B01 PC31 LAB CLASSRM DIM8100 DELL 152.2.81.131 M65527
 

8644B01 PC4 LAB CLASSROOM DIM8100 DELL 152.2.81.104 M65529
 

CNDFD11 PC41 OUTER LAB DIM8200 DELL 152.2.81.141 M65598
 

5WRFD11 PC42 OUTER LAB DIM8200 DELL 152.2.81.142 M66610
 

CVRFD11 PC43 OUTER LAB DIM8200 DELL 152.2.81.143 M66611
 

JTRFD11 PC44 OUTER LAB DIM8200 DELL 152.2.81.144 M66614
 

BDZMD11 PC45 OUTER LAB DIM8200 DELL 152.2.81.145 M66608
 

8Q34B01 PC46 OUTER LAB DIM8100 DELL 152.2.81.146 M65530
 

6844B01 PC47 OUTER LAB DIM8100 DELL 152.2.81.147 M65531
 

5544B01 PC48 OUTER LAB DIM8100 DELL 152.2.81.148 M65532
 

7T34B01 PC49 OUTER LAB DIM8100 DELL 152.2.81.149 M65533
 

G644B01 PC5 LAB CLASSRM DIM8100 DELL 152.2.81.105 M65534
 

GUD28 PC58 OUTER LAB OPTIPLEX GX110 DELL 152.2.81.158 M61145 
 

1T34B01 PC6 LAB CLASSRM DIM8100 DELL 152.2.81.106 M65576
 

7Q34B01 PC7 LAB CLASSRM DIM8100 DELL 152.2.81.107 M65536
 

3844B01 PC8 LAB CLASSRM DIM8100 DELL 152.2.81.108 M65537
 

C844B01 PC9 LAB CLASSRM DIM8100 DELL 152.2.81.109 M65538
 

NeedData20 PEARL SERVER NETWORK LAB SUN FIRE 280R SUN 152.2.81.5 M65503 
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C2BWF11 PELICAN SERVER SERVER ROOM     

        

       

     

      

      

      

      

      

      

     

    

    

    

    

       
       

    

     

      

POWEREDGE 2550 DELL 152.2.81.7 M66791
 

FQKND PR-COMM ADMIN OFFICE GX1 DELL 152.2.81.237 M65503
 

FQKMT PR-COMM2 ADMIN OFFICE GX1 DELL 152.2.81.239 M65503
 

GUGHB RECEPTION ADMIN OFFICE OPTIPLEX GX110 DELL 152.2.81.248 M61130

BTRFD11 RND-0 PHD OFFICE DIM8200 DELL 152.2.81.190 M65503
 

4NDFD11 RND-1 PHD OFFICE DIM8200 DELL 152.2.81.191 M65503
 

9VRFD11 RND-2 PHD OFFICE DIM8200 DELL 152.2.81.192 M65503
 

5MDFD11 RND-3 PHD OFFICE DIM8200 DELL 152.2.81.193 M65503
 

2VRFD11 RND-4 PHD OFFICE DIM8200 DELL 152.2.81.194 M65503
 

3TRFD11 RND-5 PHD OFFICE DIM8200 DELL 152.2.81.195 M65503
 

FQKN8 RND-6 PHD OFFICE OPTIPLEX GX1 DELL 152.2.81.196 M65503
 

GUGI2 ROOM208 CLASSROOM208 OPTIPLEX GX110 DELL 152.2.81.80 M65503
 

GUGHI ROOM214 CLASSROOM214 OPTIPLEX GX110 DELL 152.2.81.84 M65503
 

GUGHT ROOM304 CLASSROOM304 OPTIPLEX GX110 DELL 152.2.81.86 M65503
 

GUGHB ROOM307 CLASSROOM307 OPTIPLEX GX110 DELL 152.2.81.87 M65503
 

NEED_DATA1 RUBY SERVER CLOSET114D ULTRAENTERPRISE SUN 152.2.81.1 M53466
GUGHU SAYE OFFICE200 OPTIPLEX GX110 DELL 152.2.81.213 M61116

GUGH8 SOLOMON OFFICE212 OPTIPLEX GX110 DELL 152.2.81.227 M65503
 

GUGHK SONNENWALD OFFICE OPTIPLEX GX110 DELL 152.2.81.231 M65503
 

FICC2 SS2 ADMIN OFFICE OPTIPLEX GX1 DELL 152.2.81.244 M65503 
 

ENTER5 STURMLAPTOP MOBILE THINKPAD IBM 152.2.81.46 M65503
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   DELL   

       

      

      

    

     

GUGHT TAUBER ADMIN OFFICE OPTIPLEX GX110 DELL 152.2.81.249 M61122
 

GUGHI THOMAS ADMIN OFFICE OPTIPLEX GX110 152.2.81.223 M61118
 

ENTER8 TIBBO-LAPTOP MOBILE THINKPAD 600X IBM 152.2.81.50 M65503
 

UNK TOPAZ OFFICE306 ULTRA 2 MODEL 2200 SUN 152.2.81.12 M65503 
 

G4GHF VARGA OFFICE115B OPTIPLEXGX110 DELL 152.2.81.217 M65503
 

295309 VIDEOCAMERARECORDER MOBILE Hi8HANDYCAM SONY NA M65503
 

GUGI1 WILDEMUTH OFFICE210 OPTIPLEX GX110 DELL 152.2.81.201 M65503
 

FICBG ZONN ADMIN OFFICE OPTIPLEX GX1 DELL 152.2.81.242 M65503
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